Oracle® WebCenter Content
Template Editor Guide for Dynamic Converter
12c (12.2.1)
E64041-01

October 2015
Documentation for using HTML Conversion Editor used for editing conversion templates in Dynamic Converter.
Contents

Preface ................................................................................................................................................................ vii
  Audience ........................................................................................................................................................ vii
  Documentation Accessibility ......................................................................................................................... vii
  Related Documents .................................................................................................................................. vii
  Conventions ................................................................................................................................................ vii

What’s New In This Guide .................................................................................................................................. ix
  New and Changed Features for Release 12c (12.2.1) .................................................................................... ix
  Other Significant Changes in this Document for Release 12c (12.2.1) ................................................... ix

1 Introduction
  1.1 About Templates ........................................................................................................................................ 1-1
  1.2 About the HTML Conversion Editor ........................................................................................................ 1-1
    1.2.1 Template Editing Options ................................................................................................................ 1-2

2 Document Handling
  2.1 About Document Handling ...................................................................................................................... 2-1
  2.2 Formatting a Text/Word Processing File .................................................................................................... 2-2
    2.2.1 Creating a Layout ............................................................................................................................ 2-2
    2.2.2 Handling Embedded Graphics ......................................................................................................... 2-3
    2.2.3 Setting Pagination Options ............................................................................................................ 2-3
  2.3 Formatting an Image File .......................................................................................................................... 2-4
    2.3.1 Creating a Layout ............................................................................................................................ 2-4
    2.3.2 Sizing Images .................................................................................................................................... 2-5
  2.4 Formatting a Presentation File ................................................................................................................. 2-5
    2.4.1 Creating a Layout ............................................................................................................................ 2-5
    2.4.2 Sizing Slides .................................................................................................................................... 2-6
  2.5 Formatting a Spreadsheet File ................................................................................................................ 2-6
    2.5.1 Creating a Layout ............................................................................................................................ 2-7
    2.5.2 Formatting Tables ............................................................................................................................ 2-7
    2.5.3 Handling Embedded Graphics ......................................................................................................... 2-7
  2.6 Formatting a Database File ....................................................................................................................... 2-8
    2.6.1 Creating a Layout ............................................................................................................................ 2-8
    2.6.2 Setting Pagination Options ............................................................................................................ 2-8
  2.7 Formatting an Archive File ....................................................................................................................... 2-8
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.4.5.2</td>
<td>Formatting Tab</td>
<td>A-20</td>
</tr>
<tr>
<td>A.4.5.3</td>
<td>Page Link Tab</td>
<td>A-21</td>
</tr>
<tr>
<td>A.4.6</td>
<td>Section Navigation</td>
<td>A-23</td>
</tr>
<tr>
<td>A.4.6.1</td>
<td>Custom Attributes Tab</td>
<td>A-24</td>
</tr>
<tr>
<td>A.4.6.2</td>
<td>Markup Tab</td>
<td>A-24</td>
</tr>
<tr>
<td>A.4.6.3</td>
<td>Formatting Tab</td>
<td>A-25</td>
</tr>
<tr>
<td>A.5</td>
<td>Output Pages</td>
<td>A-26</td>
</tr>
<tr>
<td>A.5.1</td>
<td>Output Pages</td>
<td>A-27</td>
</tr>
<tr>
<td>A.5.2</td>
<td>Add Output Text Formats</td>
<td>A-29</td>
</tr>
<tr>
<td>A.5.3</td>
<td>Output Text Formats</td>
<td>A-30</td>
</tr>
<tr>
<td>A.5.3.1</td>
<td>Output Text Formats - Markup Tab</td>
<td>A-31</td>
</tr>
<tr>
<td>A.5.3.2</td>
<td>Output Text Formats - Formatting Tab</td>
<td>A-32</td>
</tr>
<tr>
<td>A.5.4</td>
<td>Add Format Mapping Rules</td>
<td>A-34</td>
</tr>
<tr>
<td>A.5.5</td>
<td>Format Mapping Rules</td>
<td>A-35</td>
</tr>
<tr>
<td>A.5.6</td>
<td>Add Output Markup Items</td>
<td>A-36</td>
</tr>
<tr>
<td>A.5.7</td>
<td>Output Markup Items</td>
<td>A-37</td>
</tr>
<tr>
<td>A.5.8</td>
<td>Add Output Page Layouts</td>
<td>A-38</td>
</tr>
<tr>
<td>A.5.9</td>
<td>Output Page Layouts</td>
<td>A-39</td>
</tr>
<tr>
<td>A.5.10</td>
<td>Navigation Layout</td>
<td>A-41</td>
</tr>
<tr>
<td>A.5.11</td>
<td>Page Layout</td>
<td>A-42</td>
</tr>
<tr>
<td>A.6</td>
<td>Previewing and Saving your Template</td>
<td>A-44</td>
</tr>
<tr>
<td>A.6.1</td>
<td>Previewing the Template XML Structure</td>
<td>A-44</td>
</tr>
<tr>
<td>A.6.2</td>
<td>Previewing aConverted Document</td>
<td>A-45</td>
</tr>
<tr>
<td>A.6.3</td>
<td>Saving your Template</td>
<td>A-45</td>
</tr>
</tbody>
</table>

Glossary
Preface

Dynamic Converter is an Oracle WebCenter Content component that provides on-demand document conversion using customizable templates. The HTML Conversion Editor is used for editing conversion templates in Dynamic Converter.

Audience

This document is intended for experienced WebCenter Content users.

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Documents

For more information, see the Oracle® WebCenter Content Dynamic Converter Administration Guide.

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><code>monospace</code></td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
What’s New In This Guide

This section summarizes the new features and significant product changes for Oracle WebCenter Content Dynamic Converter in the Oracle Fusion Middleware 12c 12.2.1 release.

New and Changed Features for Release 12c (12.2.1)

Oracle WebCenter Content Release 12c (12.2.1) includes the following new and changed features for this document:

■ Users can now import different style sheets or document templates into the template editor. See Chapter 5, "Output Pages"

■ A few pages in the Dynamic Converter User Interface are modified to support deprecation of the Transit Template editor (also known as Classic HTML Conversion Template Editor). Using the existing Classic HTML Conversion Templates is still available for converting content, but creating new templates or editing existing templates is not available due to the deprecation. See Appendix A, "HTML Conversion Editor User Interface"

■ Customers who prefer to view spreadsheets in a HTML browser, but for various reasons want to limit the size of the spreadsheet being viewed, can now modify the spreadsheet output. See Chapter 2, "Document Handling"

Other Significant Changes in this Document for Release 12c (12.2.1)

For Release 12c (12.2.1), this guide has been updated in several ways. Following are the sections that have been added or changed.

■ Removed Appendix "Classic HTML Conversion Editor User Interface"
Introduction

This is an introduction to the Dynamic Converter Template Editor.
The following topics are covered in this section:

- About Templates
- About the HTML Conversion Editor

1.1 About Templates

A template is a set of formatting instructions you can associate with a source
document. When you check a document into Content Server, you either associate it
with a default conversion template, or you can create a new customized template.

The following template options are available:

- HTML Conversion templates: These template types can be configured in a
cross-platform editor.
- Script templates: These run with default settings, and can be edited with a text
  editor.

After you have chosen a template type to associate with your document, and named
the template, you can edit the template. The HTML Conversion Editor is used to
customize the appearance of native documents converted to an HTML format, and
control the look and feel of the web pages you create.

To turn a source document into a web page, you can use the default settings to
perform a conversion. Alternatively, you can create a template, associate it with the
document, and then edit the template.

1.2 About the HTML Conversion Editor

The HTML Conversion Editor’s primary goal is setting options that allow you to
produce faithful representations of source files using the HTML, GIF, JPEG, and PNG
formats. You can use the HTML Conversion Editor to set various options that affect
the content and structure of the output.

The HTML Conversion Editor is Java-based and can run in any browser instance
where a JRE is present. It is downloaded onto the client machine when the Edit
Template button is clicked on either the Edit Templates page or Template Selection
Rules page. With some browsers, such as Firefox, you may be prompted for how to
handle the file dc_hcmapedit.jnlp. The correct way to open this file is with Java(TM)
Web Start Launcher (default).

Here are some of the advantages of the HTML Conversion Editor:
When launching within Content Server, the parent browser window can navigate away, yet the HTML Conversion Editor stays open, and can still save changes to the template.

HTML Conversion Templates are generated as XML files; the Tools menu option provides a view of the Template XML being generated by the editor front end.

HTML Conversion Templates can have multiple layouts. One template can provide different layout types for different document types.

Native doc metadata and optional custom properties can be placed in a converted document's body or metatags.

The HTML Conversion Editor’s Navigation Elements are greatly improved over the previous navigation elements. They allow navigation to be linked directly to particular styles.

The HTML Conversion Editor allows the use of an external CSS file.

### 1.2.1 Template Editing Options

The HTML Conversion Editor gives you broad control over how a template interprets a source document and converts it to HTML.

There are four main HTML Conversion Editor pages for editing templates:

- **Document Formatting:** This page contains several tabs that allow you to customize the formatting of your converted files according to file type. See Chapter 2, "Document Handling," for more information.

- **Document Properties:** This section of the HTML Conversion Editor allows you to specify predefined and custom document properties to be placed in the head or body of the document. See Chapter 3, "Document Properties," for more information.

- **Generated Content:** Generated content is made up of two kinds of elements: Text Elements, which define special formatting in the output; and Navigation Elements, which help automatically generate navigation links. See Chapter 4, "Generated Content," for more information.

- **Output Pages:** The Output Pages section contains options for defining HTML Output, including markup items, and formatting of text, page layouts, and navigation layouts. See Chapter 5, "Output Pages," for more information.
This chapter describes document handling.
The following topics are covered in this section:

- About Document Handling
- Formatting a Text/Word Processing File
- Formatting an Image File
- Formatting a Presentation File
- Formatting a Spreadsheet File
- Formatting a Database File
- Formatting an Archive File

2.1 About Document Handling

Document Handling is one of the four main menu options in the HTML Conversion Editor. This page contains tabs that allow you to set format options for the converted HTML output of six different types of files.

- Text/Word Processing options apply to text files, word-processing documents, and emails.
- Image options apply to graphic file types, such as JPEG, BMP, and PDF.
- Presentation options apply to presentation file types.
- Spreadsheet options apply to spreadsheet file types such as Excel and Quattro Pro.
- Database options apply to database file types.
- Archive options apply to archive file types such as ZIP and PST.

Email messages are handled as a separate document type, but are currently treated as a subset of word-processing documents. The following WP options are applied to email messages:

- layout
- Ignore unnamed character styles
- Generate list bullets using <li> tags
- Break page when hard page break is encountered
- Page size
Also, attachments are always converted as separate output files, with a link to each attachment displayed in the email header.

Unsupported file formats are processed using the word-processing options.

A layout can be specified for each document type, to allow the template author to customize the appearance of the output to the type of document being converted.

For multi-section documents such as graphic files, presentations, spreadsheets and databases, the template author can specify a default section label to use if the document does not specify one, as well as specifying formatting for the section label. A simple numbering scheme is used; for example, if “Sheet” is specified as the default title of a spreadsheet, unnamed sections will be titled “Sheet 1”, “Sheet 2”, and so on, according to the index of the section.

2.2 Formatting a Text/Word Processing File

The Text/Word Processing Tab lets you set options that define the layout of HTML output from conversion of a text or word processing file. The following sections describe how you set up the layout:

- "Creating a Layout" on page 2-2
- "Handling Embedded Graphics" on page 2-3
- "Setting Pagination Options" on page 2-3

2.2.1 Creating a Layout

The first section of the Text/Word Processing Tab allows you to control the overall look of a converted text/word processing file.

1. Navigate to Output Pages > Output Page Layouts, and click Add. The Output Page Layouts page appears.
2. In the Name field, enter a name to define this layout, for example, text/wp.
3. If you want to include a navigation layout with the page layout, click the box in front of Include navigation layout. This option allows the user to create a "table of contents" page.
4. Navigate back to the Text/Word Processing Tab of the Document Handling page. Click the down arrow in the Layout drop-down box, and select the name of the page layout that you just created (text/wp).
5. If you place a check in front of Generate list bullets without <li> tags (default), bullets/numbers for each list entry will be generated instead of using HTML list tags. Generated bullets/numbers tend to have higher fidelity to the look of the original document, but do so at the expense of not placing the list in HTML list tags. The generated bullets/numbers as well as the paragraph text will be treated as being ordinary paragraph text. If this option is not checked, then HTML list tags are used, but the types of bullets and numbers seen in the browser are severely limited.
6. If you place a check in front of Include footnotes and endnotes (default), footnotes and endnotes from the input document are included in the output. Footnotes are always placed at the end of the HTML page on which the note is referenced. Endnote placement is determined by the Separate endnotes option, shown next.
7. If you place a check in front of **Separate endnotes** (default), endnotes are placed on a separate page at the end of the document. Otherwise, endnotes are handled as being a continuation of the last page of output. The **Break on pages** option must be enabled in the Page Layout for this option to take effect.

8. If you place a check in front of **Ignore unnamed character styles**, formatting from unnamed character styles in the source document is ignored and will not be present in the output. This is useful when the template author wishes to override the formatting of paragraphs in the output via format mapping. Without this option, formatting specified in the template could potentially be overridden if the source document was not well-formatted, for example by the document writer selecting a block of text and applying a character format to it rather than specifying a style.

9. **Page width** and **Page margins** can be specified, inherited from the source document, or omitted.

10. In the **Note separator** field, enter any HTML markup that you want to put between the body and the footnotes/endnotes at the end of the page (such as a rule). The default is to do nothing unless HTML markup is specified here.

### 2.2.2 Handling Embedded Graphics

These options allow you to specify how to handle embedded graphics on HTML output from text/word processing files.

1. In the **Set maximum width (in pixels) to x** field, enter the number of pixels by which you want to shrink overly large images to no more than this many pixels wide. If a change is needed, the aspect ratio of the source image is preserved. Setting this to zero (0) means there is no limit.

2. In the **Set maximum height (in pixels) to x** field, enter the number of pixels by which you want to shrink overly large images to no more than this many pixels high. If a change is needed, the aspect ratio of the source image is preserved. Setting this to zero (0) means there is no limit.

3. In the **Set maximum size (in pixels) to x** field, enter the number of pixels by which you want to shrink overly large images to no more than this many pixels in area. If a change is needed, the aspect ratio of the source image is preserved. Setting this to zero (0) means there is no limit.

### 2.2.3 Setting Pagination Options

The pagination options allow you to control how page breaks are handled in the converted HTML output.

1. Navigate to Output Pages > Output Page Layout > [your layout name, e.g., text/wp] > Page Layout. Place a check in front of the **Break on pages** option so that pagination may occur in the HTML output.

2. Navigate back to the **Text/Word Processing Tab** of the Document Handling page. If you place a check in front of **Split file into multiple pages**, and place a check in front of **Split file at hard page breaks**, the output will be split into additional output files every time a hard page break is encountered in the source document. Note that tables will never be split across page boundaries.

3. Pages can be defined by hard page breaks and/or a word count. In the **characters per page** field, you may set a suggested page size in characters for the output generated. This means that the output is broken up into pages of
approximately the requested size in numbers of characters in the source document.

This feature is particularly useful when converting documents that are poorly structured. Many documents lack the kind of style information that Dynamic Converter uses to break the document into "output markup items." By setting this option, the exported document can be presented as a set of pieces that are more manageable rather than a single large output file. It is also useful with documents that are structured but have large pieces in the structure.

Only text inserted from the source document is counted in this size; markup and text inserted from the template are not counted. In addition, HTML markup tags generated by this product are not counted in the page size. Setting this option to zero effectively turns it off.

When this option is turned on, the page breaking rules are as follows:

- A page boundary will be created if the current paragraph causes the page size to be exceeded. Therefore, the normal operation of this feature may cause pages to exceed the specified page size by small amounts, i.e., less than a paragraph.
- A page boundary will never be created in the middle of a table, list, footnote, or endnote.

2.3 Formatting an Image File

The Image Tab lets you set options that define the layout of HTML output from conversion of an image file. The following sections describe how you set up the layout:

- "Creating a Layout" on page 2-4
- "Sizing Images" on page 2-5

2.3.1 Creating a Layout

The first section of the Image Tab allows you to control the overall look of a converted image file.

1. Navigate to Output Pages > Output Page Layout, and click Add. The Output Page Layouts page appears.
2. In the Name field, enter a name to define this layout (for example, grafx).
3. Navigate back to the Image Tab of the Document Handling page. Click the down arrow in the Layout drop-down box, and select the name of the page layout that you just created (grafx).
4. If you want to define a format to use for a Section Title (instead of using the default paragraph style), first navigate to Output Pages > Output Text Formats, and click Add. The Output Text Formats page appears.
5. In the Name field, enter a name to define this format, for example, Section Title. You can also specify a tag to use for this paragraph format, and custom markup to be inserted before or after the paragraph.
6. Navigate back to the Image Tab of the Document Handling page. Click the down arrow in the Section title format drop-down box, and select the name of the text format that you just created (Section Title).
7. In the Default section label text box, specify the default label to be used in section-based navigation.
2.3.2 Sizing Images

The following options enable you to control the sizing of images in the HTML output of image conversions.

1. Place a check in front of Set exact width (in pixels) to x and specify a value by which the conversion will shrink or enlarge the image so that the width exactly matches the specified value. If Set exact height (in pixels) to x is not set, then the image will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.

2. Place a check in front of Set exact height (in pixels) to x and specify a value by which the conversion will shrink or enlarge the image so that the height exactly matches the specified value. If Set exact width (in pixels) to x is not set, then the image will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.

3. Place a check in front of Set maximum width (in pixels) to x and specify a value by which the conversion will shrink very large images to no more than this many pixels wide. If a change is needed, the aspect ratio of the source image is preserved. The default (0) means there is no maximum width.

4. Place a check in front of Set maximum height (in pixels) to x and specify a value by which the conversion will shrink very large images to no more than this many pixels high. If a change is needed, the aspect ratio of the source image is preserved. The default (0) means there is no maximum height.

5. Place a check in front of Set maximum size (in pixels) to x and specify a value by which the conversion will shrink very large images to no more than this many pixels in area. If a change is needed, the aspect ratio of the source image is preserved. The default (0) means there is no maximum size.

6. Under Pagination, place a check in front of Split file into multiple pages to cause each image in the file to be output on a separate page.

2.4 Formatting a Presentation File

The Presentation Tab lets you set options that define the layout of HTML output from conversion of a presentation file. The following sections describe how you set up the layout:

- "Creating a Layout" on page 2-5
- "Sizing Slides" on page 2-6

2.4.1 Creating a Layout

The first section of the Presentation Tab allows you to control the overall look of a converted presentation file.

1. Navigate to Output Pages > Output Page Layout, and click Add. The Output Page Layouts page appears.

2. In the Name field, enter a name to define this layout (for example, slides).

3. Navigate back to the Presentation Tab of the Document Handling page. Click the down arrow in the Layout drop-down box, and select the name of the page layout that you just created (slides).
4. If you want to define a format to use for a Section Title (instead of using the default paragraph style), first navigate to Output Pages > Output Text Formats, and click Add. The Output Text Formats page appears.

5. In the Name field, enter a name to define this format (for example, Section Title). You can also specify a tag to use for this paragraph format, and custom markup to be inserted before or after the paragraph.

6. Navigate back to the Presentation Tab of the Document Handling page. Click the down arrow in the Section title format drop-down box, and select the name of the text format that you just created (Section Title).

7. In the Default section label text box, specify the default label to be used in section-based navigation.

2.4.2 Sizing Slides

The following options enable you to control the sizing of the slides in the HTML output of presentation file conversions.

1. Place a check in front of Set exact width (in pixels) to x and specify a value by which the conversion will shrink or enlarge the slide so that the width exactly matches the specified value. If Set exact height (in pixels) to x is not set, then the slide will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.

2. Place a check in front of Set exact height (in pixels) to x and specify a value by which the conversion will shrink or enlarge the slide so that the height exactly matches the specified value. If Set exact width (in pixels) to x is not set, then the slide will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.

3. Place a check in front of Set maximum width (in pixels) to x and specify a value by which the conversion will shrink very large slides to no more than this many pixels wide. If a change is needed, the aspect ratio of the source slide is preserved. The default (0) means there is no maximum width.

4. Place a check in front of Set maximum height (in pixels) to x and specify a value by which the conversion will shrink very large slides to no more than this many pixels high. If a change is needed, the aspect ratio of the source slide is preserved. The default (0) means there is no maximum height.

5. Place a check in front of Set maximum size (in pixels) to x and specify a value by which the conversion will shrink very large slides to no more than this many pixels in area. If a change is needed, the aspect ratio of the source slide is preserved. The default (0) means there is no maximum size.

6. Under Pagination, check the box in front of Split file into multiple pages to cause each slide in the document to be output on a separate page.

2.5 Formatting a Spreadsheet File

The Spreadsheet Tab lets you set options that define the layout of HTML output from conversion of a spreadsheet file. The following sections describe how you set up the layout:

- "Creating a Layout" on page 2-7
- "Formatting Tables" on page 2-7
- "Handling Embedded Graphics" on page 2-7
2.5.1 Creating a Layout

The first section of the Spreadsheet Tab allows you to control the overall look of a converted spreadsheet file.

1. Navigate to Output Pages > Output Page Layouts, and click Add. The Output Page Layouts page appears.
2. In the Name field, enter a name to define this layout (for example, ss).
3. Navigate back to the Spreadsheet Tab of the Document Handling page. Click the down arrow in the Layout drop-down box, and select the name of the page layout that you just created (ss).
4. If you want to define a format to use for a Section Title (instead of using the default paragraph style), first navigate to Output Pages > Output Text Formats, and click Add. The Output Text Formats page appears.
5. In the Name field, enter a name to define this format (for example, Section Title). You can also specify a tag to use for this paragraph format, and custom markup to be inserted before or after the paragraph.
6. Navigate back to the Spreadsheet Tab of the Document Handling page. Click the down arrow in the Section title format drop-down box, and select the name of the text format that you just created (Section Title).
7. In the Default section label text box, specify the default label to be used in section-based navigation.

2.5.2 Formatting Tables

There are two options on the Spreadsheet Tab that apply to how spreadsheet tables are formatted in HTML output.

1. Check the box in front of Show grid lines to force the table representing the spreadsheet to be output with a "border" value of "1."
2. Under Pagination, check the box in front of Split file into multiple pages to cause each table in the document to be output on a separate page. If the rows per page option is set to a nonzero value, the spreadsheet will be rendered as a series of tables containing up to the specified number of rows on each page.

2.5.3 Handling Embedded Graphics

These options allow you to specify how to handle embedded graphics on HTML output from spreadsheet files.

1. In the Set maximum width (in pixels) to x field, enter the number of pixels by which you want to shrink overly large images to no more than this many pixels wide. If a change is needed, the aspect ratio of the source image is preserved. Setting this to zero (0) means there is no limit.
2. In the Set maximum height (in pixels) to x field, enter the number of pixels by which you want to shrink overly large images to no more than this many pixels high. If a change is needed, the aspect ratio of the source image is preserved. Setting this to zero (0) means there is no limit.
3. In the Set maximum size (in pixels) to x field, enter the number of pixels by which you want to shrink overly large images to no more than this many pixels in area. If a change is needed, the aspect ratio of the source image is preserved. Setting this to zero (0) means there is no limit.
2.6 Formatting a Database File

The Database Tab lets you set options that define the layout of HTML output from conversion of a database file. The following sections describe how you set up the layout:

- "Creating a Layout" on page 2-8
- "Setting Pagination Options" on page 2-8

2.6.1 Creating a Layout

The first section of the Database Tab allows you to control the overall look of a converted database file.

1. Navigate to Output Pages > Output Page Layout, and click Add. The Output Page Layouts page appears.
2. In the Name field, enter a name to define this layout (for example, db).
3. Navigate back to the Database Tab of the Document Handling page. Click the down arrow in the Layout drop-down box, and select the name of the page layout that you just created (db).
4. If you want to define a format to use for a Section Title (instead of using the default paragraph style), first navigate to Output Pages > Output Text Formats, and click Add. The Output Text Formats page appears.
5. In the Name field, enter a name to define this format, for example, Section Title. You can also specify a tag to use for this paragraph format, and custom markup to be inserted before or after the paragraph.
6. Navigate back to the Database Tab of the Document Handling page. Click the down arrow in the Section title format drop-down box, and select the name of the text format that you just created (Section Title).
7. In the Default section label text box, specify the default label to be used in section-based navigation.

2.6.2 Setting Pagination Options

This section allows you to set pagination options for the HTML output of a converted database file.

1. Under Pagination, check the box in front of Split file into multiple pages to cause each record in the document to be output on a separate page.
2. Enter a value in the x records per page text box to specify the number of records to output on each page.

2.7 Formatting an Archive File

The Archive Tab lets you set options that define the layout of HTML output from conversion of an archive file. The following sections describe how you set up the layout:

- "Creating a Layout" on page 2-9
- "Setting Display Method" on page 2-9
2.7.1 Creating a Layout

The first section of the Archive Tab allows you to control the overall look of a converted spreadsheet file.

1. Navigate to Output Pages > Output Page Layout, and click Add. The Output Page Layouts appears.

2. In the Name field, enter a name to define this layout (for example, archive).

3. Navigate back to the Archive Tab of the Document Handling page. Click the down arrow in the Layout drop-down box, and select the name of the page layout that you just created (archive).

2.7.2 Setting Display Method

There are two options in the Display method drop-down box:

- If you select file names, the names of files and folders in the archive will be output.
- If you select decompressed files, the file names will be output as links to the exported files.
This chapter describes document properties.

The following topics are covered in this section:

- About Document Properties
- Defining Document Properties

### 3.1 About Document Properties

The Add Document Property page allows you to add or remove document properties. There are two types of document properties: predefined and custom.

- Predefined properties are metadata fields stored in many file formats. An example of this is the **Primary author**, which is the author of the input document. Exactly which properties are available is highly dependent on the input file format, and in most cases it also depends on whether or not the author provided this information.

- Custom properties are defined by the author. These can be used to insert arbitrary text and HTML markup into the output files.

The template author can choose predefined properties from the document to be output as metadata or as content in the output. Custom properties can also be created for insertion into the head and/or body of the output file. For each property, the template author can specify a default value to be inserted into the document should a value not be available, either from the document or the runtime API. The meta tag name is the name that identifies the property when placed in a `<meta>` tag in the head of the document. If the property is to be output in the body of the document, the text can be formatted using the specified output format.

By default, no document properties are defined. In order to include them in the output from the conversion, each desired document property must first be defined here. They must then be added to the output from the conversion by inserting them into page layouts defined in the Output Page Layouts page.

### 3.2 Defining Document Properties

The following steps allow you to define document properties:

1. In the Add Document Property page, click **Add**. The Document Property page is displayed.
2. The first field offers the option between Predefined and Custom.
- In the **Predefined** drop-down box, select from a list of metadata fields stored in many file formats.

- In the Custom text box, you may include properties not listed in the **Predefined** drop-down. To do this, click on the **Custom** button and type in either the property name as it appears in the source document, or a new property name that you will create. Property names are case-sensitive.

3. In the **Default value** text box, enter the default value to use if the property is not found in the input document being converted. This is also used as the value for custom properties. Providing a default value is optional.

4. In the **Meta tag name** text box, if the property is to appear in an HTML meta tag, then this is the value of the "name" attribute to use in the meta tag. The value of the "content" attribute will be taken from the source document or the **Default value** option set above, as appropriate.

   If there is no author specified in the input document then the meta tag generated will be:

   ```html
   <meta name="author" content="Unknown">
   ```

   While providing a meta tag name is optional, it must be specified if the property is to be included with the rest of the meta tags in the `<head>` of the output files. Properties that have a meta tag name defined are automatically added to the `<head>`; the user cannot add properties via the Head layout section.

5. In the **Output format** drop-down box, select the name of the previously defined output paragraph format. This will be used to format the property when including the property's value in the output as visible text. Output paragraph formats are defined in Output Pages > Output Text Formats.
This chapter describes the use of generated content.

The following topics are covered:

- About Generated Content
- Adding a Text Element
- Adding a Navigation Element

4.1 About Generated Content

Generated content is made up of two kinds of elements:

- Text Elements, which allow the user to insert text strings into the output from the template or from the server at the time of conversion.
- Navigation Elements, which provide links to specific document elements.

4.2 Adding a Text Element

Text elements are a way to insert text specified in the HTML Conversion template directly into the output. Text elements work exactly the same way as custom document properties except text elements cannot be placed in the <head> of the document in a <meta> tag.

By default, no text elements are defined. In order to include them in the output from the conversion, each desired text element must first be defined here. They must then be added to the output from the conversion by inserting them into page layouts defined in the Output Page Layouts.

1. Navigate to Generated Content > Text Elements. Click Add. The Text Element page is displayed.

   To remove a Text Element, select a defined text element from the list and click Remove. An element may not be removed if it is used by a page layout.

2. In the Name text box, enter the name to use to reference this text element when creating/editing page layouts. This field is required.

3. In the Value text box, enter the value to insert into the output when this text element is used in a page layout.

4. In the Use output format drop-down box, select the name of the output format. This will be used to format the text element when including its value in the output as visible text. Output formats are defined under Output Text Formats.
4.3 Adding a Navigation Element

Navigation elements allow you to generate navigation links in the HTML output. The following sections define how to create the three kinds of navigation elements:

- "Adding Document Navigation" on page 4-2
- "Adding Page Navigation" on page 4-3
- "Adding Section Navigation" on page 4-4

4.3.1 Adding Document Navigation

Document Navigation is a way to link to various items in the source document based on the document's structure. A common example of how one would use this type of navigation is to create links to all the paragraphs marked with outline level 1 (such as "Heading 1" paragraphs) in the document. Before using this form of navigation, link mapping rules must first be added. This is done on the Mapping Rules Tab.

1. Navigate to Generated Content > Navigation. In the drop-down box, select navigation by . . . and then select either document element navigation, page navigation, or document section navigation. Select document element and click Add to add an element of that type. The Element Navigation page appears.

2. In the Name field, enter a name by which the page layouts will refer to this navigation element. This is required.

3. In the Link tag drop-down box, specify whether to use an anchor or option tag (<a> or <option>) to enclose the links in this element.

4. Place a check in front of Generate parent levels when "orphan" levels are encountered to generate clean outline levels. When creating navigation based on outline levels, problems can arise when the document being converted is "sloppy" in its use of outline levels. An example of such sloppy outlining would be a paragraph tagged with outline level 1 followed later by one tagged with outline level 3 without an outline level 2 paragraph somewhere in between. That outline level 3 paragraph is considered to be an "orphan level."

   By setting this option, the Markup to insert before this set of links and the Markup to insert after this set of links entered in the Custom Attributes Tab from the link set (defined below) are inserted into the output for the orphan level.

   By default, this option is not set. An example of navigation that does not need to worry about orphan levels would be one where the link set did not need to define any Markup to insert before this set of links or Markup to insert after this set of links.

5. Place a check in front of Only include links to targets on the same page to generate a small set of links to targets that all appear in the same output HTML page. An example of this would be to break a document up so there is one outline level 1 paragraph in each output HTML page. The user could then set this option as part of creating a line of links across the top of the page that go to all the outline level 2’s that appear on the page.

   If this option is not set (the default), then links to targets across the entire document are generated.

6. Enter a value for Word limit for labels to truncate the label after the specified number of words. The link's label is taken from the text of the document element the link goes to. Some target elements may contain large amounts of text. This can cause problems in the formatting of the list of links.
Setting this option to 0, the default, causes the entire target element's text to be used as the link label.

7. In the Link Sets section, you can add a definition (such as outline level 1) for which rules may be defined. Once link sets have been added, their order may be arranged by using the Levels up/down arrows. The order that link sets appear in the window establishes navigation hierarchy. When a link set is moved up or down, its name changes accordingly; for example, if two link sets are defined (Level 1 and Level 2) and the second one is selected and moved up, it becomes the Level 1 link set.

8. The Link Sets section has four tabs:
   - The Mapping Rules tab allows the template author to define the target of the navigation, either by outline level or (case-sensitive) style name.
   - The Custom Attributes tab allows custom attributes to be applied to the links.
   - On the Markup tab, the tags or other markup for rendering the link set are defined.
   - Finally, the Formatting tab allows the template author to apply styling to the link labels, either directly or via an external CSS class.

9. In the Mapping Rules Tab, you can mark document content for navigation. Match on either an outline level or style and provide the name in the Value field.

10. In the Custom Attributes Tab, enter specific HTML tags that you want to appear in the output before and after the link set. Click the Add attribute button to insert a new "name/value" pair. Highlight a row in this table and click the Remove Attribute button to delete custom attributes.

11. In the Markup Tab, you can specify custom markup that can be inserted before and after each link in the set, and/or between links.

12. In the Formatting Tab, you can choose one of two ways to specify the formatting for links.

   If you place a check in front of Use external CSS class, then you must enter the name of a class from an external CSS file here. The URL of the external CSS file is specified with the External user stylesheet option set in Output Pages.

   If you choose to use Character Formatting, the types of character level formatting available are evident from the screen. Each type of formatting can be set to one of four values:
   - Always off - Forces the attribute to be always off when formatting the link.
   - Always on - Forces the attribute to be always on when formatting the link.

4.3.2 Adding Page Navigation

This provides a way to link to certain key pages in the output (first page, next page, etc.). It also provides a way to link to external pages (such as to http://www.oracle.com/).

1. Navigate to Generated Content > Navigation. In the drop-down box, select navigation by page. Click Add to add an element of that type. The Page Navigation page appears.

2. In the Name field, enter the name by which the page layouts will refer to this navigation element. This is required.
3. In the **Link tag** drop-down box, specify whether to use an anchor or option tag (<a> or <option>) to enclose the links in this element.

4. In the **Markup Tab**, enter any custom HTML tagging that should be inserted before, between, and/or after this set of links.

5. In the **Formatting Tab**, you can choose one of two ways to specify the formatting for links.

   If you place a check in front of **Use external CSS class**, then you must enter the name of a class from an external CSS file here. The URL of the external CSS file is specified with the **External user stylesheet** option set in **Output Pages**.

   If you choose to use Character Formatting, the types of character level formatting available are evident from the screen. Each type of formatting can be set to one of four values:

   - **Always off** - Forces the attribute to be always off when formatting the link.
   - **Always on** - Forces the attribute to be always on when formatting the link.

6. In the **Page Link Tab**, you can specify navigation links, and then determine their order.

### 4.3.3 Adding Section Navigation

This provides navigation for multi-section documents, such as spreadsheets and presentations.

1. Navigate to Generated Content > Navigation. In the drop-down box, select **navigate by document section**. Click **Add** to add an element of that type. The **Section Navigation** page appears.

2. In the **Name** field, enter the name by which the page layouts will refer to this navigation element. This is required.

3. In the **Link tag** drop-down box, specify whether to use an anchor or option tag (<a> or <option>) to enclose the links in this element.

4. In the **Custom Attributes Tab**, enter any custom name/value pair for a new tag attribute.

5. In the **Markup Tab**, you can specify custom markup that can be inserted before and after each link in the set, and/or between links.

6. In the **Formatting Tab**, you can choose one of two ways to specify the formatting for links.

   If you place a check in front of **Use CSS class**, then you must enter the name of a class from an external CSS file here. The URL of the external CSS file is specified with the **External user stylesheet** option set in **Output Pages**.

   If you choose to use Character Formatting, the types of character level formatting available are evident from the screen. Each type of formatting can be set to one of four values:

   - **Always off** - Forces the attribute to always be off when formatting the link.
   - **Always on** - Forces the attribute to always be on when formatting the link.
The Output Pages section describes how to set options for general HTML output, as well as for Markup Items, Text Formats, and Page Layouts.

The following topics are covered:

- Configuring HTML Settings
- Configuring Output Markup Items
- Configuring Output Text Formats
- Setting Format Mapping Rules
- Configuring Output Page Layouts

### 5.1 Configuring HTML Settings

The top-level Output Pages page allows you to set general options for HTML output.

1. Place a check in front of **Use DOCTYPE** to insert a DOCTYPE statement at the top of each output file. If CSS is enabled, the HTML generated conforms to the XHTML 1.0 Transitional DTD. If CSS is disabled, HTML 4.0 Transitional-conformant HTML is output. This option is enabled by default.

2. In the **Language string** text box, enter the value of the "lang" attribute of the `<html>` tag. This indicates the primary natural language of the document.

3. In the **CSS generation** drop-down box, you can specify whether Cascading Style Sheet ("CSS") formatting will be used, and if so, the method of CSS presentation. CSS enables HTML Converter to create output with higher fidelity with respect to the source document. Please note that CSS support varies from browser to browser.

This option can be set to the following values:

- none - only HTML tags will be used for formatting.
- embedded - CSS styles will be included in the head of each output file.
- external - CSS styles will be output in a separate file, which is referenced by all output files generated during the conversion.
- inline - CSS style information will be included in every paragraph. This option can drastically increase the size of the output file, but is necessary when the template is used to generate fragments.

By default, the CSS is embedded in the HTML of each output file. This reduces the total number of files generated by the conversion, as there is no need to create a
separate CSS file. Note that if a style is needed anywhere in the final output of the conversion, it will appear in the style definitions of every HTML file.

4. In the **External user stylesheet** text box, enter the URI of that CSS file and the appropriate reference to it will be placed in the output HTML file(s). An example of where this would be useful is if you need to maintain a site requiring multiple templates with a common look and feel to the site. Without using this feature, a change to the site’s look would require that multiple templates be updated. With a common .css file, however, you only need to change the style definition in one place and all conversions are updated at once.

If this option is left blank, the system will generate CSS styles based on how elements are defined under **Text Element**.

This option is ignored if the **CSS generation** option above is set to none.

5. In the **Output character set** drop-down box, select which character set should be used in the output file. The HTML Conversion editor will then translate or “map” characters from the input document’s character set to the output character set as needed. This character mapping is limited by the need for the character to be in both the input and the output character sets. If a character cannot be mapped, the character will show up in the output as the “unmappable character” determined by the **Value for unmappable characters** option described below. If the resulting output contains an excessive number of these unmapped characters, selecting a more appropriate output character set should improve the situation.

The HTML standards currently limit documents to a single output character set. That character set is specified in an output file using the CONTENT attribute of the <meta> tag. This limits what the technology can do with documents that have multiple character sets. In general, documents that are a mix of a single Asian language and English characters will translate correctly (although with some possible loss of non-alphanumeric characters) if the appropriate DBCS, UTF-8, or Unicode output character set is selected. This is because most DBCS character sets include the standard 7-bit Latin 1 characters. Documents that contain more than one DBCS character set or a DBCS character set and a non-English character set (such as Cyrillic) may not export with all the character glyphs intact unless Unicode or UTF-8 is used.

Source documents that contain characters from many character sets will look best when this option is set to the default, Unicode (UTF-8). This is because the Unicode and UTF-8 character sets contain almost all characters for the most common languages.

While the W3C recommends using Unicode, there is a downside to it at this time. Not all systems have the appropriate fonts needed for using Unicode or UTF-8. Many editors do not understand these character sets, as well. In addition, there are some differences in the way browsers interpret the byte order of 2-byte Unicode characters (which is why both big and little endian Unicode are available settings for this option).

6. In the **Value for unmapped characters** text box, enter the hex value for the character used when a character cannot be found in the output character set. The default value of 2A corresponds to the asterisk (“*”) character.

Note that when the **CSS generation** option described above has been set, there will be no unmappable characters in the HTML. Instead, the unmapped character will be written out in &#....; notation using the decimal representation of the character’s Unicode value. Newer browsers support this representation and will convert it to the appropriate character if it is available in the font being used. If the character is not available in that font, the browser’s unmappable character symbol
(typically a rectangular box) will be seen. Also, note that there may still be unmapped characters in text rendered to graphics. This is because the graphic file is generated at conversion time rather than being rendered by the browser.

7. In the Graphics format drop-down box, specify the format of the graphics produced by the system. The following values are allowed:
   - GIF
   - JPEG (default)
   - PNG
   - None

When setting this option, remember that the JPEG file format does not support transparency. Though the GIF file format supports transparency, it is limited to using only one of its 256 available colors to represent a transparent pixel (“index transparency”).

PNG supports many types of transparency. The PNG files written are created so that various levels of transparency are possible for each pixel. This is achieved through the implementation of an 8-bit “alpha channel”. However, at this time the technology will ignore transparency data when metafiles with multiple layers are converted.

8. If you selected GIF, the Interlaced GIF checkbox becomes available. This is checked by default. Interlaced images cause less monitor flicker than non-interlaced ones.

9. In the Output DPI text box, enter a value from 0 to 2400 to specify the output graphics device’s resolution in DPI. This only applies to objects whose size is specified in physical units (in/cm). For example, consider a 1-inch square, 100 DPI graphic that is to be rendered on a 50 DPI device (Output DPI option set to 50). In this case, the size of the resulting JPEG, GIF, BMP or PNG will be 50 x 50 pixels.

While this option is used to help compute table sizes, it is primarily a graphics option. Early browsers and versions of the HTML standard limit the specification of image sizes to dimensions in pixels. For images in particular, this is somewhat natural as GIF, JPEG, BMP, and PNG are bitmap formats whose sizes are defined in pixels. However, many of the source graphics and tables converted specify their size in physical units such as inches or centimeters, and there is no way to know how big a pixel is on the target device for the converted document. In fact, a single document may ultimately be viewed on many devices, each with a different number of pixels or dots per inch (DPI). If graphics are converted too small, image detail will be lost. Conversely, if the graphics are converted too large, conversion times will suffer and files will take longer to download.

Setting this option to 0 may result in the creation of extremely large images. Be aware that there may be limitations in the system running this technology that could result in undesirably large bandwidth consumption or an error message. Additionally, an out-of-memory error message will be generated if system memory is insufficient to handle a particularly large image.

Also note that setting this option to 0 will force the technology to use the DPI settings already present in raster images. For any other type of input file, the current screen resolution will be used as the DPI setting.

10. If you have selected JPEG as your graphics format, the JPEG quality text box becomes available. The default (100) delivers the highest quality and largest file size.
11. In the **Image sizing method** drop-down box, you can select from the following options:
   - quick
   - smooth
   - grayscale

   Each of these options involves some degree of trade-off between the quality of the resulting image and the speed of conversion.

12. In the **Custom target attribute** drop-down box, select your preference for how the browser should select which frame or window in which to open source document links. The following values specify the target attribute of the links the system generates in these cases. This target value will be applied to all such links encountered in the source document.
   - No setting - This means that no target attribute will be included in links from the source document.
   - _self - This means that the document is loaded in the same frame as the element that refers to this target (essentially the same as not specifying a target at all).
   - _parent - This means that the document is loaded into the immediate FRAMESET parent of the current frame. This value is equivalent to _self if the current frame has no parent.
   - _top - This means that the document is loaded into the full, original window (thus canceling all other frames). This value is equivalent to _self if the current frame has no parent.
   - _blank - This means that links are opened in a new, unnamed window.

13. Place a check in front of **Format HTML source for readability** (default) to write newlines to the output strictly to make the generated HTML more readable and visually appealing. These newlines only appear in the places where you have set **Add a newline before this paragraph** under **Output Text Formats**.

   It is important to note the things that setting this option does not do:
   - While setting this option will make it easier for a human to read the generated markup in a text editor, it does not affect the browser's rendering of the document.
   - This option does not affect the contents of the .css files, since they do not contain any text from the source document.
   - The option does not affect spaces or newlines copied from the template, as the contents of the template are already under the control of the user.

14. Place a check in front of **Show style information** to include information about source document style names and how they are mapped by the template being used. The user can see what format has been mapped to a particular paragraph or text sequence by mousing over it.

### 5.2 Configuring Output Markup Items

Markup items are HTML fragments that may be inserted directly into the output HTML as part of a page layout. Each markup item is a name/value pair. The name is what will appear in the screens for editing page layouts. The value is a block of HTML that will be inserted into the output HTML wherever the markup item appears in a
page layout. There is one default name in this section, break, whose value is defined as \(<br />\).

1. Click Add to display the Output Markup Items page. A new item called Output Markup Item appears in the lefthand tree view under Output Markup Items, below the default item, break.

2. In the Name field, assign a name by which you will refer to this item, for example, rule. The display on the lefthand tree view changes to reflect this name.

3. In the Markup text box, enter the HTML fragment to be associated with this item, for example, \(<br />\).

4. To remove a markup item from the template, highlight the name of the item in the tree and click Remove.

### 5.3 Configuring Output Text Formats

Output text formats define text and formatting attributes of output document text. These formats will define such attributes as the font family, size, and color, standard text attributes (bold, italic, underline, etc) and border attributes. This allows the template author to standardize the look of the output despite differing formatting styles used by the various authors of the source documents. There is one default format in this section, Default Paragraph, whose tag is \(p\). Output Text Formats created here can then be be organized according to Format Mapping Rules, which pick the formatting based on checking the type of source document text.

---

**Note:** Users should be aware that text formats are only applied to text from word processing files. They cannot be used to change the formatting of text that is rendered as part of any graphics generated by the conversion. They are also not applied to text inside spreadsheets.

---

1. Click Add to display the Output Text Formats - Markup Tab. A new item called Output Text Format appears in the lefthand tree view under Output Formats, below the default item, Default Paragraph. To remove a paragraph item from the template, highlight the name of the item in the tree and click Remove.

2. In the Name field, assign a name by which you will refer to this format, for example, Bold Italic. This name then appears in the lefthand tree view.

3. In the Tag name text box, enter the HTML paragraph-level tag to put around paragraphs using this format. Note that any "tag" name may be entered here, whether it is legal or not. Only the tag name should be entered, not the surrounding angle brackets ("<" and ">"). The paragraph tag ("p") is the default.

4. Click Add Attribute to add a new name/value pair to the Custom Attributes table. These attributes apply to the tag whose name was specified above. To set the name and value of the new attribute, just click on them in the Custom Attributes table. By default, this table is empty. To remove an attribute, highlight the name in the table and click Remove attribute.

5. In the Custom Markup text boxes, enter any HTML (or regular text) to be placed before and/or after the paragraph.

6. Check the box in front of Insert a newline in the HTML before this paragraph to insert a blank line into the HTML before the paragraph to make it easier to view the HTML output of the conversion. This option does not affect how the output...
5.4 Setting Format Mapping Rules

Format mapping rules allow you to specify output document formatting and the sequence in which rules are checked.

1. On the Add Format Mapping Rules page, click Add Format Mapping Rule. The Format Mapping Rules page is displayed, and a new item shows up in the
left-hand navigation pane called **outline level** = x. Once rules have been defined, this page will allow you to arrange the rules by using the **Move Up** and **Move Down** buttons. The mapping rules are ordered so that the first rule that matches is the one, and only one, that is applied.

For example, a rule may be created for mapping paragraphs in the **My Style** style. Below that rule, another rule may exist for mapping paragraphs with **outline level 1** applied. An input document may have one or more paragraphs in the **My Style** style that also have **outline level 1** applied. In this example the technology will only apply the **My Style** formatting to such paragraphs and ignore the **outline level 1** rule for them.

2. On the **Format Mapping Rules** page, click the down arrow on the **Format** drop-down box. Choose one of the previously defined output text formats to apply when this mapping rule is in effect. The Default Paragraph format is always available and is always the default. See **Configuring Output Text Formats** for details on how to create new formats to use here.

3. Under **Match on**, click the down arrow on the drop-down box to define the paragraph formatting information to have the rule check.
   - Outline level - Match the outline level specified in the source document. Application-predefined "heading" styles typically have corresponding outline levels applied as part of the style definition.
   - Style name - Match the paragraph or character style name.
   - Is footnote - Match any footnote.
   - Is endnote - Match any endnote.
   - Is header - Match any document header text.
   - Is footer - Match any document footer text.

4. For **Paragraph outline level**, if **Match on** above is set to **Outline level**, then this defines which outline level to match. This option cannot be set/is ignored for all other matching rules.

5. For **Paragraph or character style**, if **Match on** above is set to **Style name**, then this defines which source document paragraph or character style name to match. When matching on style names, the template author must supply a style name here, and no default value is provided. The name must exactly match the style name from the source document. Style name matching is done in a case-sensitive manner. This option cannot be set/is ignored for all other matching rules.

### 5.4.1 Mapping Source Document Styles to CSS Styles

This example shows how to map the heading styles found in the source document to CSS styles for the HTML display.

1. To map the heading style, first you must add an Output Text Format. Navigate to **Output Pages > Output Text Format**, click **Add** and give it a name, Heading 1.

2. In the **Tag name** text box, enter the HTML tag to use in the output, in this case, h1.

3. On the Formatting tab, allow all formatting to be inherited from the source.

4. Next, you must define a Format Mapping Rule that matches on the style name. Mapping rules can use different criteria to map document text to a format. Navigate to Format Mapping Rules in the left-hand pane, and click **Add Format Mapping Rule**.
5. In the Format drop-down menu, select the name of the Output Text Format you created, Heading 1.

6. In the Match on drop-down menu, select Style name.

7. In the Paragraph or character style text box, enter a name for the style exactly as it appears in the source document, such as Heading 1.

8. When you exit the editor, you will be prompted to save the template.

5.5 Configuring Output Page Layouts

Page layouts are used to organize how the various parts of the output are arranged. This includes such items as where to place a Table of Contents in the output document. A default layout has been provided for users who need output that is pleasing to the eye, but are not particular about the details of their output.

Users may create multiple page layouts, each optimized for a specific file type. The Document Handling page allows you to specify which page layout to use.

1. In the Add Output Page Layouts page, click Add. The newly added layout will appear on the left side navigation screen and you will be auto-navigated to the new layout for editing. The Output Page Layouts page is displayed.

2. In the Name field, fill in the name to use to refer to this layout (required). Once this has been done, click on the icon on the left side of the editor to expand the levels underneath this one. There are three items: <title> Source, Navigation Layout, and Page Layout.

3. Check the Include navigation layout option if you want a table of contents page preceding the document content.

4. Click on the Title Source page to select where to get the value to use for the HTML <title> tag. By default, this is empty for new layouts, although the <title> tag will always be output in order to conform to the DTD. There are four options you can select for the source of the <title> tag:

   - Section Name - Use the title for the current document section. Section titles are not available in all document formats, such as word processing files. Two examples of where this is very useful are presentations, where this corresponds to the slide title; and spreadsheets/database files, where this corresponds to the sheet name. Using the section name works well with output layouts that place one slide/sheet in each output HTML page. In this situation, each page would have a title that matches the title of its contents. If the page layout does not break the document by sections, the name of the first section will be used as the title text.

   - Text Element - Use a text element already defined under Text Element. Using a text element for the title makes a good fail-safe entry at the bottom of the list, just in case all other title sources are undefined/unavailable.

   - Property - Use any document property already defined under Document Property.

   - Output Text Format - Use an output paragraph format already defined under Output Text Formats. The first non-empty instance of a paragraph in this format is used.

5. In the Navigation Layout page, you can select navigation elements previously defined for inclusion in the output page layout. The purpose of the navigation layout is to generate a separate Table of Contents HTML page based on mapping
rules defined on Mapping Rules Tab. This navigation page becomes the first output file of the conversion and is completely independent of other page breaking rules in the output.

Only navigation items and markup can be inserted into the body of the navigation layout. Page navigation is not supported in the navigation layout; it is intended for use with document and section layout items.

Use of a navigation layout is optional. If one is used, you can specify markup items to be placed in either the Head and/or the Body.

- For the Head item, you can define the content that will be placed in the HTML <head> of all of the output files this layout applies to. The following items are placed by default in the head:
  - A <meta> tag stating the character set in which the HTML file is encoded.
  - A <title> tag, the contents of which are defined in the Title Source page.
  - A <meta> tag stating that the HTML was generated.

If the CSS generation option was selected on Output Pages, then CSS style definitions generated by the technology are included, either in a <style> tag (for embedded CSS) or with a <link> tag to a CSS file generated by the conversion.

If the External CSS stylesheet option was selected on Output Pages, then an HTML <link> tag to the user specified CSS file is included.

Also, any markup items previously defined under Output Markup Items can be inserted here. The markup items specified on this screen will appear in the head after all of the auto-generated items listed above. By default, there is nothing listed here.

- For the Body item, you can define the content that will be placed in the body of the navigation page created by this layout. The following items may be placed in the top:
  - Markup Item - A text and HTML markup item defined under Output Markup Items.

6. In the Page Layout, you can enable document pagination with the following options:

   - Break on sections - If checked, enables page breaking on document sections. Only applicable for multi-section documents.
   - Break on pages - If checked, enables page breaking based on the document-specific pagination options.

7. If you click on Head, you can define the content that will be placed in the HTML <head> of all the output files generated from this layout. The following items are placed by default in the head:

   - A <meta> tag stating the character set in which the HTML file is encoded.
   - A <title> tag, the contents of which are defined in the Title Source page.
   - A <meta> tag stating that the HTML was generated.
- `<meta>` tags for all document properties defined under Document Property that specify a **Meta tag name**.
- If the **CSS generation** option was selected on Output Pages, then CSS style definitions generated by the technology are included.
- If the **External CSS stylesheet** option was selected on Output Pages, then an HTML `<link>` tag to the user specified CSS file is included.
- Also, any markup items previously defined under Output Markup Items can be inserted here. The markup items specified on this screen will appear in the head after all of the auto-generated items listed above. By default, there is nothing listed here.

8. If you click on **Page Top**, you can define the content that will be placed at the top of every output file to which this layout is applied. This content will appear just after the HTML `<body>` tag. In order to place anything in the page top, those items first need to be defined elsewhere in the template. An example of typical Page Top content might be a navigation bar with links to the first page, previous page, and next page in the output. By default, the HTML Conversion editor leaves the **Page Top** empty. The following items may be placed:
   - **Header** - The header from the input document.
   - **Navigation Item** - A navigation item defined on Add Navigation Element.
   - **Document Property** - A document property defined on Document Property.
   - **Markup Item** - A text and HTML markup item defined on Output Markup Items.
   - **Text Element** - A text element defined on Text Element.

9. If you click on **Before Content**, you can define the content to be placed before the start of output for the converted document, but not on every page. An example of such content might be a standard cover page to be created for all converted documents. By default, the HTML Conversion editor leaves **Before Content** empty. The following items may be placed:
   - **Document Property** - A document property defined on Document Property.
   - **Markup Item** - A text and HTML markup item defined on Output Markup Items.
   - **Text Element** - A text element defined on Text Element.

10. If you click on **Before Section**, you can define content to be placed before each section of a document. The following document formats support multiple sections: spreadsheets, presentations, images, and databases. Users should note that although a format may support multiple sections, the specific file being converted may still only have one section. An example of a typical use of this layout area is to insert a couple of blank lines and a horizontal rule to prevent sections from running together. By default, the HTML Conversion editor leaves **Before Section** empty. The following items may be placed:
    - **Section Name** - The name of the current section. If the name of the current section is not specified in the source document or is undefined (such as in word processing documents), then nothing will be inserted. Adding this type of item brings up a simple screen where the author selects which Output Format to use for the element.
    - **Document Property** - A document property defined on Document Property.
11. If you click on **After Content**, you can define the content to be placed after the end of document content. This content will come after any footnotes or endnotes if the template specifies them. By default, the HTML Conversion editor leaves **After Content** empty. The following items may be placed:

- Header - The header from the input document.
- Footer - The footer from the input document.
- Document Property - A document property defined on **Document Property**.
- Markup Item - A text and HTML markup item defined on **Output Markup Items**.
- Text Element - A text element defined on **Text Element**.

12. If you click on **Page Bottom**, you can define the content that will be placed at the bottom of every output file to which this layout is applied. This content will appear just before the closing HTML <body> tag. An example of such content might be a copyright notice. By default, the HTML Conversion editor leaves **Page Bottom** empty. The following items may be placed:

- Footer - The footer from the input document.
- Navigation Item - A navigation item defined on **Add Navigation Element**.
- Document Property - A document property defined on **Document Property**.
- Markup Item - A text and HTML markup item defined on **Output Markup Items**.
- Text Element - A text element defined on **Text Element**.
The Dynamic Converter HTML Conversion Editor consists of several administrative pages that you use to customize your HTML conversion templates. The HTML Conversion Editor gives you broad control over how a template interprets a source document and converts it to HTML. It provides an intuitive interface for setting the various options that control the content and appearance of output generated by the conversion.

The following sections describe the various parts of the user interface and the options available to the template author. The interface is organized according to these four options:

- **Document Handling**: This page contains several tabs that allow you to customize the formatting of your converted files according to file type.
  - Text/Word Processing Tab
  - Image Tab
  - Presentation Tab
  - Spreadsheet Tab
  - Database Tab
  - Archive Tab

- **Document Properties**: This section of the HTML Conversion Editor allows you to specify predefined and custom document properties to be placed in the head or body of the document.
  - Add Document Property
  - Document Property

- **Generated Content**: Generated content is made up of two kinds of elements:
  - Text elements, which define custom strings that can be used as replacement strings in the template or at run-time via a server API call. These strings can be output as-is or with formatting defined in the template.
  - Navigation elements, which automatically generate navigation links.

The following pages are available:

- Add Text Elements
- Text Element
- Add Navigation Element
- Element Navigation
- Page Navigation
- Section Navigation

- **Output Pages:** The Output Pages section contains options for HTML output, including markup items, and formatting of text, page layouts, and navigation layouts. This section of the interface contains the following pages that allow you to customize output:
  - Output Pages
  - Add Output Text Formats
  - Output Text Formats
  - Add Format Mapping Rules
  - Format Mapping Rules
  - Add Output Markup Items
  - Output Markup Items
  - Add Output Page Layouts
  - Navigation Layout
  - Page Layout

### A.1 Getting Started

The menu bar at the top of the HTML Conversion Editor contains three items:

- **File**, which contains the command to exit the editor. If the template has been modified, the user is prompted to save the changes before exiting.

- **Tools**, which contains commands to validate the template and to display the XML contents of the template.

  **Note:** The template is validated automatically when it is saved. It is not required to validate templates manually during edits.

- **Help**, which contains commands to display this help file and the About box.

Beneath the menu bar is a button bar that lets you enter the content ID of a document that will be used to preview the effects of the template in a conversion prior to checking in the template. Click **Preview** to run the conversion and display the output using the default web browser.

The left side of the editor displays the different categories of options, organized as a functional flow from input document to finished output.

- **Document Handling** includes options specific to each document type.

- The **Document Properties page** allows the user to specify which document properties to display in the output, or create custom properties.

- In **Generated Content**, the template author defines navigation elements and custom text elements.

- **Output Pages** allows the user to specify basic characteristics of the generated output, such as the character set and the format for exported graphics. **Output Text Formats** allows the creation of text formats and mapping rules for transforming word-processing document content. In **Output Markup Items** the template author
defines custom markup to be inserted into the output. Finally, the layout of the generated content is defined in the Output Page Layouts page.

A.2 Document Handling

The Document Handling page allows you to customize the formatting of your converted files according to file type:

- "Text/Word Processing Tab" on page A-3
- "Image Tab" on page A-4
- "Presentation Tab" on page A-6
- "Spreadsheet Tab" on page A-7
- "Database Tab" on page A-9
- "Archive Tab" on page A-10

A.2.1 Text/Word Processing Tab

The Text/Word Processing tab allows you to set formatting options for text and word processing files.

Figure A–1  Document Handling - Text/Word Processing Tab

Table A–1 lists the Text/Word Processing Tab elements and the element descriptions.
Table A–1  Text/Word Processing Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Select which layout to use for this type of document. The layout controls the overall look of the document. Page layouts are defined under Output Page Layouts, and can then be selected from the drop-down menu.</td>
</tr>
<tr>
<td>Generate list bullets without &lt;li&gt; tags</td>
<td>Specifies whether lists should be output using HTML list tags (ordered list/unordered list) or as normal paragraphs with the appropriate decoration to indicate the list item. In some cases, greater fidelity to the source document is possible when this option is selected.</td>
</tr>
<tr>
<td>Include footnotes and endnotes</td>
<td>If checked, footnotes and endnotes from the input document are included in the output. Footnotes are always placed at the bottom of their respective pages. Endnote placement is determined by the Separate endnotes option.</td>
</tr>
<tr>
<td>Separate endnotes</td>
<td>If checked, endnotes are placed on a separate page at the end of the document. Otherwise, they are placed on the last page of output.</td>
</tr>
<tr>
<td>Ignore unnamed character styles</td>
<td>If checked, formatting from unnamed character styles in the source document is ignored. This is useful when creating a template that normalizes the formatting of document content, either directly or through external CSS.</td>
</tr>
<tr>
<td>Page width and Page margins</td>
<td>Page width and Page margins can be specified, inherited from the source document, or omitted.</td>
</tr>
<tr>
<td>Note separator</td>
<td>This allows you to specify markup, such as a &lt;hr&gt; tag, for separating footnotes and endnotes from the document content on a page. If both footnotes and endnotes are output on the same page, there will still be one occurrence of the separator markup between the document content and the first footnote.</td>
</tr>
<tr>
<td>Embedded graphics</td>
<td>These options allow you to impose size limits on embedded graphics, by width, height, or total number of pixels. The aspect ratio of the graphic is preserved regardless of the method specified. A value of 0 indicates no limit.</td>
</tr>
<tr>
<td>Pagination</td>
<td>These options enable the splitting of the output into multiple files and determine the conditions for creating a new page. Pages can be defined by hard page breaks and/or a word count. Note that tables will never be split across page boundaries.</td>
</tr>
</tbody>
</table>

A.2.2 Image Tab

The Image tab allows you to customize formatting options specific to image files.
Table A–2 lists the elements and element descriptions for Document Handling - Image tab.

Table A–2  Document Handling - Image Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Selects which layout to use for image files. The layout controls the overall look of the document. Page layouts are defined under Output Page Layouts, and can then be selected from the drop-down menu.</td>
</tr>
<tr>
<td>Section title format</td>
<td>Specifies the format to be applied to the Section Title layout item.</td>
</tr>
<tr>
<td>Default section label</td>
<td>Specifies the default label to be used in section-based navigation.</td>
</tr>
<tr>
<td>Set exact width (in pixels) to x</td>
<td>Shrinks or enlarges the image so that the width exactly matches the specified value. If <strong>Set height to exactly</strong> x is not set, then the image will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.</td>
</tr>
<tr>
<td>Set exact height (in pixels) to x</td>
<td>Shrinks or enlarges the image so that the height exactly matches the specified value. If <strong>Set width to exactly</strong> x is not set, then the image will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.</td>
</tr>
<tr>
<td>Set maximum width (in pixels) to x</td>
<td>Shrinks very large images to no more than this many pixels wide. If size reduction is required, the aspect ratio of the source image is preserved. The default (0) means there is no maximum width.</td>
</tr>
</tbody>
</table>


### Table A–2 (Cont.) Document Handling - Image Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set maximum height (in pixels) to x</td>
<td>Shrinks very large images to no more than this many pixels high. If size reduction is required, the aspect ratio of the source image is preserved. The default (0) means there is no maximum height.</td>
</tr>
<tr>
<td>Set maximum size (in pixels) to x</td>
<td>Shrinks very large images to no more than this many pixels in area. If size reduction is required, the aspect ratio of the source image is preserved. The default (0) means there is no maximum size.</td>
</tr>
<tr>
<td>Split file into multiple pages</td>
<td>If checked, the images in multi-section graphic files such as TIFF or DXF will be output on separate pages.</td>
</tr>
</tbody>
</table>

### A.2.3 Presentation Tab

The Presentation tab allows you to customize the formatting options for presentations.

**Figure A–3 Document Handling - Presentation Tab**

Table A–3 lists the elements and element descriptions for Document Handling - Presentation tab.
**Table A–3  Document Handling - Presentation Tab Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Selects which layout to use for presentation files. The layout controls the overall look of the document. Page layouts are defined under Output Page Layouts, and can then be selected from the drop-down menu.</td>
</tr>
<tr>
<td>Section title format</td>
<td>Specifies the format to be applied to the Section Title layout item.</td>
</tr>
<tr>
<td>Default section label</td>
<td>Specifies the default label to be used in section-based navigation.</td>
</tr>
<tr>
<td>Set exact width (in pixels) to x</td>
<td>Shrinks or enlarges the slide so that the width exactly matches the specified value. If Set height to exactly x is not set, then the slide will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.</td>
</tr>
<tr>
<td>Set exact height (in pixels) to x</td>
<td>Shrinks or enlarges the slide so that the height exactly matches the specified value. If Set width to exactly x is not set, then the slide will be scaled without altering its original aspect ratio. Setting this option to zero causes it to be ignored.</td>
</tr>
<tr>
<td>Set maximum width (in pixels) to x</td>
<td>Shrinks very large slides to no more than this many pixels wide. If a change is needed, the aspect ratio of the source slide is preserved. The default (0) means there is no maximum width.</td>
</tr>
<tr>
<td>Set maximum height (in pixels) to x</td>
<td>Shrinks very large slides to no more than this many pixels high. If a change is needed, the aspect ratio of the source slide is preserved. The default (0) means there is no maximum height.</td>
</tr>
<tr>
<td>Set maximum size (in pixels) to x</td>
<td>Shrinks very large slides to no more than this many pixels in area. If a change is needed, the aspect ratio of the source slide is preserved. The default (0) means there is no maximum size.</td>
</tr>
<tr>
<td>Split file into multiple pages</td>
<td>If checked, each slide in the document will be output in a separate file.</td>
</tr>
</tbody>
</table>

**A.2.4 Spreadsheet Tab**

The Spreadsheet tab allows you to set formatting options relevant to spreadsheets.
**Table A–4** lists the elements and element descriptions for Document Handling - Spreadsheet Tab.

**Table A–4  Document Handling - Spreadsheet Tab Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Selects which layout to use for this type of document. The layout controls the overall look of the document. Page layouts are defined under <strong>Output Page Layouts</strong>, and can then be selected from the drop-down menu.</td>
</tr>
<tr>
<td>Section title format</td>
<td>Specifies the format to be applied to the Section Title layout item.</td>
</tr>
<tr>
<td>Default section label</td>
<td>Specifies the default label to be used in section-based navigation.</td>
</tr>
<tr>
<td>Show grid lines</td>
<td>HTML tables are used to render spreadsheets. This option causes the table to be output with the &quot;border&quot; attribute set, so that the cell boundaries are visible. If the option is not set, only borders specified by the document will be output.</td>
</tr>
<tr>
<td>Set maximum width (in pixels) to x</td>
<td>Shrinks very large images to no more than this many pixels wide. If a change is needed, the aspect ratio of the source image is preserved. The default (0) means there is no limit.</td>
</tr>
<tr>
<td>Set maximum height (in pixels) to x</td>
<td>Shrinks very large images to no more than this many pixels high. If a change is needed, the aspect ratio of the source image is preserved. The default (0) means there is no limit.</td>
</tr>
<tr>
<td>Set maximum size (in pixels) to x</td>
<td>Shrinks very large images to no more than this many pixels in area. If a change is needed, the aspect ratio of the source image is preserved. The default (0) means there is no limit.</td>
</tr>
</tbody>
</table>
A.2.5 Database Tab

The Database tab allows you to specify formatting options specific to database files.

Table A–5 lists the elements and their descriptions for Document Handling - Database Tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split file into multiple pages</td>
<td>Checking this option will cause each sheet in the document to be output on a separate page. Note that tables will never be split across page boundaries.</td>
</tr>
<tr>
<td>x rows per page</td>
<td>If the rows per page option is set to a nonzero value, the spreadsheet will be rendered as a series of tables containing up to the specified number of rows on each page.</td>
</tr>
</tbody>
</table>

Table A–5 (Cont.) Document Handling - Spreadsheet Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Selects which layout to use for this type of document. The layout controls what the overall look of the document. Page layouts are defined under Output Page Layouts, and can then be selected from the drop-down menu.</td>
</tr>
<tr>
<td>Section title format</td>
<td>Specifies the format to be applied to the Section Title layout item.</td>
</tr>
</tbody>
</table>
A.2.6 Archive Tab

The Archive tab allows you to specify formatting options specific to archive files.

Table A–6 lists the elements and descriptions for the Document Handling - Archive tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default section label</td>
<td>Specifies the default label to be used in section-based navigation.</td>
</tr>
<tr>
<td>Split file into multiple pages</td>
<td>Setting this option will cause each section of the document to be output on a separate page.</td>
</tr>
<tr>
<td>x records per page</td>
<td>If the records per page option is set to a nonzero value, the database will be rendered as a series of tables, each containing up to the specified number of records.</td>
</tr>
</tbody>
</table>

Table A–6 | Document Handling - Archive Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Selects which layout to use for this type of document. The layout controls the overall look of the document. Page layouts are defined under Output Page Layouts, and can then be selected from the drop-down menu.</td>
</tr>
</tbody>
</table>
A.3 Document Properties

This section of the Editor allows you to specify predefined and custom document properties to be placed in the head or body of the document.

The following pages are available in this section:

- "Add Document Property" on page A-11
- "Document Property" on page A-12

A.3.1 Add Document Property

The Add Document Property page allows you to add and remove document properties.

Figure A–7  Add Document Property

Table A–7 lists the elements and descriptions for Add Document Property tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display method</td>
<td>Archive files (for example, ZIP) are rendered as a series of tables representing the file hierarchy of the archive. The default display method is <strong>file names</strong>, in which only the file list will be output. If the display method is set to <strong>decompressed files</strong>, each file in the archive will also be rendered based on the appropriate template settings for that document type. The file listing will contain links to the rendered files.</td>
</tr>
</tbody>
</table>
Table A–7  Add Document Property Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to add a new document property.</td>
</tr>
<tr>
<td>Remove</td>
<td>Select a defined document property from the list and click this button to remove it. A property may not be removed if it is used by a page layout.</td>
</tr>
</tbody>
</table>

A.3.2 Document Property

The Document Property page allows you to define two types of document properties: predefined and custom.

Figure A–8  Document Property

Table A–8 lists the elements and descriptions for Document Property tab.

Table A–8  Document Property Tab - Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predefined</td>
<td>Predefined properties are metadata fields stored in many file formats. An example of this is the <strong>Primary author</strong>, which is the author of the input document. Exactly which properties are available is highly dependent on the input file format and in most cases it is also dependent on whether or not the author provided this information.</td>
</tr>
<tr>
<td>Custom</td>
<td>Custom properties are defined by the author. These can be used to insert arbitrary text and HTML markup into the output files. By default, no document properties are defined. In order to include them in the output from the conversion, each desired document property must first be defined here. They must then be added to the output from the conversion by inserting them into page layouts defined under <strong>Output Page Layouts</strong>.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value to use if the property is not found in the input document being converted. This is also used as the value for custom properties. Providing a default value is optional.</td>
</tr>
</tbody>
</table>
| Meta tag name | If the property is to appear in an HTML meta tag, then this is the value of the 'name' attribute to use in the meta tag. The value of the 'content' attribute will be taken from the source document or the **Default value** option set above, as appropriate. If there is no author specified in the input document, then the meta tag generated will be as follows:  
  <meta name="author" content="Unknown">  
  While providing a meta tag name is optional, it must be specified if the property is to be included with the rest of the meta tags in the <head> of the output files. |
A.4 Generated Content

Generated content is made up of two kinds of elements:

- Text elements, which define custom strings that can be used as replacement strings in the template or at run-time via a server API call. These strings can be output as-is or with formatting defined in the template.
- Navigation elements, which automatically generate navigation links.

The following pages are available:

- "Add Text Elements" on page A-13
- "Text Element" on page A-14
- "Add Navigation Element" on page A-15
- "Element Navigation" on page A-16
- "Page Navigation" on page A-19
- "Section Navigation" on page A-23

A.4.1 Add Text Elements

The Add Text Elements page enables you to access the Text Elements page, which allows you to specify text to be inserted into the converted output.
Table A–9 lists the elements and descriptions for Add Text Elements tab.

**Table A–9  Add Text Elements - Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to display the Text Element page to add a new text element.</td>
</tr>
<tr>
<td>Remove</td>
<td>Select a defined text element from the list and click this button to remove it. An element may not be removed if it is used by a page layout.</td>
</tr>
</tbody>
</table>

**A.4.2 Text Element**

The Text Element page allows you to set a name/value for new text elements.

Table A–10 lists the elements and descriptions for Text Element tab.
### Table A–10  Text Element tab - Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name by which this text element will be referred when creating/editing page layouts. This field is required.</td>
</tr>
<tr>
<td>Value</td>
<td>The value to insert into the output when this text element is used in a page layout. By default, this is left blank.</td>
</tr>
<tr>
<td>Use output format</td>
<td>The name of the output format. This will be used to format the text element when including its value in the output as visible text.</td>
</tr>
</tbody>
</table>

### A.4.3 Add Navigation Element

The Add Navigation Element page enables you to access pages that allow you to place navigation links in the converted output. There are three kinds of navigation elements: document navigation, page navigation, and section navigation.

### Figure A–11  Add Navigation Element

![Add Navigation Element](image)

Table A–11 lists the elements and descriptions for Add Navigation Element tab.

### Table A–11  Add Navigation Element tab - Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>navigation by ...</td>
<td>Click the drop-down box next to the Add button to select whether a document navigation, page navigation, or section navigation element will be added.</td>
</tr>
</tbody>
</table>
A.4.4 Element Navigation

The Element Navigation page enables you to provide local/global navigation to document elements for word processing documents. It has the following subordinate Link Set pages:

- "Mapping Rules Tab" on page A-17
- "Custom Attributes Tab" on page A-18
- "Markup Tab" on page A-18
- "Formatting Tab" on page A-19

Table A–12  Element Navigation tab - Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to display the document navigation, page navigation, or section navigation page to define the element.</td>
</tr>
<tr>
<td>Remove</td>
<td>Highlight a navigational item and click this button to remove navigational elements that are no longer needed. A navigational element may not be removed if it is used by a page layout.</td>
</tr>
</tbody>
</table>

Table A–12 lists the elements and descriptions for Element Navigation tab.

Table A–12  Element Navigation tab - Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name by which the page layouts will refer to this navigation element. Required.</td>
</tr>
</tbody>
</table>
A.4.4.1 Mapping Rules Tab

The Mapping Rules tab allows you to access the Link Mapping Rule page. Link mapping rules establish which parts of the input document will be used to create links.

Figure A–13  Link Mapping Rule

Table A–12  (Cont.)  Element Navigation tab - Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link tag</td>
<td>Specifies whether to use <code>&lt;a&gt;</code> or <code>&lt;option&gt;</code> to enclose the links in this element.</td>
</tr>
<tr>
<td>Generate parent levels when “orphan” levels are encountered</td>
<td>This option causes missing link levels to be added so that the link hierarchy starts at level 1.</td>
</tr>
<tr>
<td>Only include links to targets on the same page</td>
<td>This is used to generate a small set of links to targets that all appear in the same output HTML page. An example of this would be to break a document up so there is one outline level 1 paragraph in each output HTML page. You could then set this option as part of creating a line of links across the top of the page that go to all the outline level 2’s that appear on the page. If this option is not set (the default), then links to targets across the entire document are generated.</td>
</tr>
<tr>
<td>Word limit for labels</td>
<td>The link's label is taken from the text of the document element. Some target elements may contain large amounts of text. This can cause problems in the formatting of the list of links. Setting this option truncates the label after the specified number of words, in which case an ellipsis will be output to indicate the truncation. Setting this option to 0, the default, causes the entire target element’s text to be used as the link label.</td>
</tr>
<tr>
<td>Link Sets</td>
<td>The Link Sets section has four tabs:</td>
</tr>
<tr>
<td></td>
<td>- The Mapping Rules tab allows the template author to define the target of the navigation, either by outline level or (case-sensitive) style name.</td>
</tr>
<tr>
<td></td>
<td>- The Custom Attributes tab allows custom attributes to be applied to the links.</td>
</tr>
<tr>
<td></td>
<td>- On the Markup tab, the tags or other markup for rendering the link set are defined.</td>
</tr>
<tr>
<td></td>
<td>- Finally, the Formatting tab allows the template author to apply styling to the link labels, either directly or via an external CSS class.</td>
</tr>
<tr>
<td>Levels</td>
<td>Once link sets have been added, their order may be arranged by using these up/down arrows. The order that link sets appear in the window establishes navigation hierarchy. When a link set is moved up or down, its name changes accordingly; for example, if two link sets are defined (Level 1 and Level 2) and the second one is selected and moved up, it becomes the Level 1 link set.</td>
</tr>
<tr>
<td>Remove</td>
<td>Highlight a link set and click this button to remove it.</td>
</tr>
</tbody>
</table>
Table A–13 lists the elements and descriptions for Link Mapping Rule.

**Table A–13  Link Mapping Rule - Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add/Remove Link Mapping Rule</td>
<td>Click the Add Link Mapping Rule icon to add a new link mapping rule to mark document content for navigation. Highlight a rule and click the Remove icon to delete it.</td>
</tr>
<tr>
<td>Move Up and Move Down</td>
<td>Once mapping rules have been added, their order may be arranged by using these buttons. The mapping rules are ordered so that the first rule that matches is the one that is applied.</td>
</tr>
<tr>
<td>Match on</td>
<td>This determines what kind of mapping rule is being created. There are two choices:</td>
</tr>
<tr>
<td></td>
<td>■ Match on outline level - Matches the numeric outline level specified. Note that a value of 0 is not allowed.</td>
</tr>
<tr>
<td></td>
<td>■ Match on style - Matches the paragraph or character style name specified. Note that matches are case sensitive.</td>
</tr>
<tr>
<td>Value (outline or style)</td>
<td>■ If Match on outline level is selected, then the outline level to match on should be entered here. The default outline level is 1.</td>
</tr>
<tr>
<td></td>
<td>■ If Match on style is selected, then the name of the style to match on should be entered here. The style name is case-sensitive and must exactly match the style name stored in the document. No default style name is given.</td>
</tr>
</tbody>
</table>

A.4.4.2 Custom Attributes Tab

The Custom Attributes tab allows you to define custom attributes and custom markup to insert before or after the link set.

Table A–14 lists the elements and descriptions for Custom Attributes Tab.

**Table A–14  Custom Attributes tab - Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom link attributes</td>
<td>Displays custom attributes specified by the user. Use the Add attribute and Remove Attribute buttons to add and delete attributes, respectively.</td>
</tr>
<tr>
<td>Name/Value</td>
<td>Any name/value pairs you wish to define. By default, this is empty.</td>
</tr>
</tbody>
</table>

A.4.4.3 Markup Tab

The Markup tab allows you to define HTML markup to be inserted before, between, and/or after links.

Table A–15 lists the elements and descriptions for Markup Tab.

**Table A–15  Markup Tab - Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Markup to insert before link</td>
<td>Any desired text or HTML that should appear before the first link. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert between links</td>
<td>Any desired text or HTML that should appear between links. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert after link</td>
<td>Any desired text or HTML that should appear after the last link. By default, this is empty.</td>
</tr>
</tbody>
</table>
### A.4.4 Formatting Tab

The Formatting tab allows you to define an external CSS class, or directly define character formatting for the link set.

**Figure A–14  Element Navigation - Formatting Tab**

Table A–16 lists the elements and descriptions for Element Navigation - Formatting tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use external CSS class</td>
<td>If this option is selected, then the author must enter the name of a class from an external CSS file here. The URL of the external CSS file is specified with the External user stylesheet option set under Output Pages.</td>
</tr>
<tr>
<td>Character Formatting</td>
<td>Each available type of character-level formatting can be set to one of two values:</td>
</tr>
<tr>
<td></td>
<td>- Always off - Forces the attribute to always be off when formatting the link.</td>
</tr>
<tr>
<td></td>
<td>- Always on - Forces the attribute to always be on when formatting the link.</td>
</tr>
</tbody>
</table>

### A.4.5 Page Navigation

Page Navigation provides page-relative navigation. This page has the following three tabs:
A.4.5.1 Markup Tab

The Markup tab allows you to insert markup before and/or after the set of links.

Figure A–15  Page Navigation - Markup Tab

Table A–17 lists the elements and descriptions for Page Navigation - Markup Tab.

Table A–17  Page Navigation - Markup Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name by which the page layouts will refer to this navigation element. Required.</td>
</tr>
<tr>
<td>Link tag</td>
<td>Choose between anchor and option for the HTML tag to be used for the link.</td>
</tr>
<tr>
<td>Markup to insert before this set of links</td>
<td>Any desired text or HTML that should appear before the set of links. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert between this set of links</td>
<td>Any desired text or HTML that should appear between the set of links. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert after this set of links</td>
<td>Any desired text or HTML that should appear after the set of links. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert before/after each link</td>
<td>Any desired text or HTML that should appear before/after each link. By default, this is empty.</td>
</tr>
</tbody>
</table>

A.4.5.2 Formatting Tab

The Formatting tab allows you to specify formatting for navigation links.
Table A–18 lists the elements and descriptions for Page Navigation - Formatting Tab.

### Table A–18  Page Navigation - Formatting Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name by which the page layouts will refer to this navigation element. Required.</td>
</tr>
<tr>
<td>Link tag</td>
<td>Choose between anchor and option for the HTML tag for this link.</td>
</tr>
<tr>
<td>Use CSS class</td>
<td>Specify the name of an externally defined class here. The URL of the CSS file is specified by the External user stylesheet option set under Output Pages.</td>
</tr>
<tr>
<td>Character Formatting</td>
<td>The available types of character-level formatting are presented. Each type of formatting can be set to one of two values:</td>
</tr>
<tr>
<td></td>
<td>- Always off - Forces the attribute to always be off when formatting the link.</td>
</tr>
<tr>
<td></td>
<td>- Always on - Forces the attribute to always be on when formatting the link.</td>
</tr>
</tbody>
</table>

### A.4.5.3 Page Link Tab

The Page Link tab allows you to add page navigation links, and then determine their order.
Figure A–17  Page Navigation - Page Link Tab

Table A–19 lists the elements and descriptions for Page Navigation - Page Link tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append page link</td>
<td>Click <strong>Append page link</strong> to add a page navigation link. Highlight a link and click <strong>Remove page link</strong> to delete it.</td>
</tr>
<tr>
<td>Link type</td>
<td>Defines the link as one of the following types:</td>
</tr>
<tr>
<td></td>
<td>■ First page - A link to the first page in the generated output. This is the default.</td>
</tr>
<tr>
<td></td>
<td>■ Previous page - A link to the previous page in the generated output.</td>
</tr>
<tr>
<td></td>
<td>■ Next page - A link to the next page in the generated output.</td>
</tr>
<tr>
<td></td>
<td>■ Navigation page - A link to the navigation page in the generated output. The navigation page is defined under Navigation Layout.</td>
</tr>
<tr>
<td></td>
<td>■ Custom URL - A link to the specified URL</td>
</tr>
<tr>
<td>Link label</td>
<td>The text to place between the HTML begin and end anchor tags. This may be any valid HTML, including an <code>&lt;img&gt;</code> tag for a graphic to use as a button for the link.</td>
</tr>
<tr>
<td>URL</td>
<td>Required if the <strong>Link type</strong> option above is set to <strong>Custom URL</strong>.</td>
</tr>
<tr>
<td>Add/Remove Custom Attributes</td>
<td>Click the <strong>Add Attribute</strong> icon to add new attributes to include in the HTML anchor tag for the page link. After clicking the button, an entry will appear in the Name/Value table. Replace the default <strong>name</strong> with the name of the attribute. Replace the default <strong>value</strong> with the value for the attribute. As an example, you might choose <strong>alt</strong> and <strong>generated</strong>, respectively. Highlight a name/value pair and click the <strong>Remove Attribute</strong> icon to delete it.</td>
</tr>
</tbody>
</table>
A.4.6 Section Navigation

Section navigation is used for multi-section document types, such as presentations and spreadsheets, and is useful for creating links to each section when pagination is not used. This is the simplest type of navigation element; the section labels are used as the link labels, and the other options in the dialog are the ones common to all of the navigation elements. This page has three tabs:

- Custom Attributes Tab
- Markup Tab
- Formatting Tab

At the top of the page, two items are displayed for all three tabs.

Table A–20 lists the elements and descriptions for Section Navigation tabs.

### Table A–20  Section Navigation Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name by which the page layouts will refer to this navigation element. Required.</td>
</tr>
<tr>
<td>Link tag</td>
<td>Specifies whether to use <code>&lt;a&gt;</code> or <code>&lt;option&gt;</code> to enclose the links in this element.</td>
</tr>
</tbody>
</table>
A.4.6.1 Custom Attributes Tab

The Custom Attributes tab allows you to insert custom markup before or after the set of links.

*Figure A–18  Section Navigation - Custom Attributes Tab*

Table A–21 lists the elements and descriptions for Section Navigation - Custom Attribute Tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom attributes</td>
<td>Displays custom attributes specified by the user. Use the <strong>Add attribute</strong> and <strong>Remove attribute</strong> buttons to add and delete attributes, respectively.</td>
</tr>
<tr>
<td>Name/Value</td>
<td>Any desired Name/Value pairs you wish to define. By default, this is empty.</td>
</tr>
</tbody>
</table>

A.4.6.2 Markup Tab

The Markup tab allows you to insert HTML markup before, between, and/or after links.
**Figure A–19  Section Navigation - Markup Tab**

![Section Navigation - Markup Tab](image)

Table A–22 lists the elements and descriptions for Section Navigation - Markup Tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Markup to insert before link</td>
<td>Any desired text or HTML that should appear before the first link. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert between links</td>
<td>Any desired text or HTML that should appear between links. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert after link</td>
<td>Any desired text or HTML that should appear after the last link. By default, this is empty.</td>
</tr>
<tr>
<td>Markup to insert before/after each link</td>
<td>Any desired text or HTML that should appear before/after each link. By default, this is empty.</td>
</tr>
</tbody>
</table>

**A.4.6.3 Formatting Tab**

The Formatting tab provides you with two different methods to specify the formatting for links.
Table A–23 lists the elements and descriptions for Section Navigation - Formatting tab.

**Table A–23  Section Navigation - Formatting Tab Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use CSS class</td>
<td>Specify the name of an externally defined class here. The URL of the CSS file is specified by the External user stylesheet option set under Output Pages.</td>
</tr>
<tr>
<td>Character Formatting</td>
<td>Each type of available character-level formatting can be set to one of two values:</td>
</tr>
<tr>
<td></td>
<td>■ Always off - Forces the attribute to always be off when formatting the link.</td>
</tr>
<tr>
<td></td>
<td>■ Always on - Forces the attribute to always be on when formatting the link.</td>
</tr>
</tbody>
</table>

**A.5 Output Pages**

The Output Pages section contains options for HTML output, including markup items, and formatting of text, page layouts, and navigation layouts. This section of the interface contains the following pages that allow you to customize output:

- "Output Pages" on page A-27
- "Add Output Markup Items" on page A-36
- "Output Markup Items" on page A-37
- "Add Output Text Formats" on page A-29
- "Output Text Formats" on page A-30
- "Add Format Mapping Rules" on page A-34
- "Format Mapping Rules" on page A-35
- "Add Output Page Layouts" on page A-38
- "Output Page Layouts" on page A-39
- "Navigation Layout" on page A-41
A.5.1 Output Pages

The Output Pages page allows you to set a variety of options regarding HTML output.

Figure A–21 Output Pages

Table A–24 lists the elements and descriptions for Output Pages tab.

Table A–24 Output Pages Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use DOCTYPE</td>
<td>Check this option to have the technology insert a DOCTYPE statement at the top of each output file. If CSS is enabled, the HTML generated conforms to the XHTML 1.0 Transitional DTD. If CSS is disabled, HTML 4.0 Transitional-conformant HTML is output. This option is enabled by default.</td>
</tr>
<tr>
<td>Language string</td>
<td>Specifies the value of the &quot;lang&quot; attribute of the &lt;html&gt; tag. This indicates the primary natural language of the document.</td>
</tr>
</tbody>
</table>
CSS generation

CSS enables Dynamic Converter to create output with higher fidelity with respect to the source document. Please note that CSS support varies from browser to browser.

This option can be set to the following values:

- **embedded** - CSS styles will be included in the head of each output file.
- **external** - CSS styles will be output in a separate file, which is referenced by all output files generated during the conversion.

By default, the CSS is embedded in the HTML of each output file. This reduces the total number of files generated by the conversion, as there is no need to create a separate CSS file. Note that if a style is needed anywhere in the final output of the conversion, it will appear in the style definitions of every HTML file.

External user stylesheet

Specifies the URI of a stylesheet to be referenced by the output. This is used in conjunction with the **Use external CSS class** option in the Character and Paragraph Formatting tabs to allow the template author to control the formatting of the document content.

Output character set

This option allows you to specify which character set should be used in the output file. The technology then translates or "maps" characters from the input document's character set to the output character set as needed.

Value for unmappable characters

This option specifies the character used when a character cannot be found in the output character set. This option takes the Unicode value for the replacement character specified in hexadecimal (the default value of 2A corresponds to the asterisk ("*"), character). You must ensure that the selected replacement character is available in the output character set.

Graphics format

This option allows the developer to specify the format of the graphics produced by the technology. The following values are allowed:

- **GIF**
- **JPEG**
- **PNG**
- **None**

Interlaced GIF

This item is available if you have selected GIF as the Graphics format. Check this box if the output graphic is to be an interlaced GIF.

Output DPI

This option allows you to specify the output graphics device's resolution in DPI and only applies to objects whose size is specified in physical units (in/cm). For example, consider a 1" square, 100 DPI graphic that is to be rendered on a 50 DPI device ("Output DPI" option set to 50). In this case, the size of the resulting JPEG, GIF, or PNG will be 50 x 50 pixels.

JPEG Quality

If the format selected is JPEG, this allows you to set the quality (1-100) of the JPEGs created by the technology.
### Table A–24 (Cont.) Output Pages Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Image sizing method      | This option determines the method used to size graphics. You can choose among three methods, each of which involves some degree of trade off between the quality of the resulting image and speed of conversion:  
  - quick  
  - smooth (default)  
  - grayscale |
| Custom target attribute  | Some input documents contain hyperlinks. Template authors may have a preference for the frame or window in which the browser opens the source document links. This option allows the template author to specify a value to use for the "target" attribute of the hyperlinks generated by the technology, and will override any target information from the source document. It does not affect hyperlinks in navigation layout items or markup. If this option is left blank, the "target" attribute will only be set if the source document provides a value for it.  
  The following are valid values for the "target" attribute in HTML:  
  - `_blank` - The user agent should load the designated document in a new, unnamed window.  
  - `_self` - The user agent should load the document in the same frame as the element that refers to this target.  
  - `_parent` - The user agent should load the document into the immediate FRAMESET parent of the current frame. This value is equivalent to `_self` if the current frame has no parent.  
  - `_top` - The user agent should load the document into the full, original window (thus canceling all other frames). This value is equivalent to `_self` if the current frame has no parent. |
| Format HTML source for readability | Checking this option causes the technology to write newlines to the output strictly to make the generated HTML more readable and visually appealing. These newlines only appear in the places where you have set **Add a newline before this paragraph**.  
  It is important to note the things that setting this option does not do:  
  - While setting this option will make it easier for a human to read the generated markup in a text editor, it does not affect the browser's rendering of the document.  
  - This option does not affect the contents of the `.css` files since they do not contain any text from the source document.  
  - The option does not affect spaces or newlines copied from the template as the contents of the template are already under user control. |
| Show style information   | Checking this box will cause Dynamic Converter to include information about source document style names and how they are mapped. You can see what format has been mapped to a particular paragraph or text sequence by mousing over it. |

### A.5.2 Add Output Text Formats

The Add Output Text Formats page allows the user to add and remove output text formats, which define formatting attributes of output document text. Output text
formats define text and formatting attributes of output document text. These formats will define such attributes as the font family, size, and color, standard text attributes (bold, italic, underline, etc.), and border attributes to use for tables. This allows the author to standardize the look of the output despite differing formatting styles used by the various authors of the source documents.

**Figure A–22  Output Text Formats - Formats Tab**

Table A–25 lists the elements and descriptions for Output Text Formats - Formats Tab.

**Table A–25  Output Text Formats - Formats Tab Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click the <strong>Add</strong> button to add a new output text format. The newly added item will appear in the left side tree view and you will be taken to that item for editing. The Default Paragraph format is always available. It essentially instructs the technology to leave the formatting in the output the same way it was in the input documents.</td>
</tr>
<tr>
<td>Remove</td>
<td>Select an output text format in the table and click <strong>Remove</strong> to delete it.</td>
</tr>
</tbody>
</table>

A.5.3 Output Text Formats

The Output Text Formats page has two tabs:

- **Output Text Formats - Markup Tab**
- **Output Text Formats - Formatting Tab**
A.5.3.1 Output Text Formats - Markup Tab

This tab allows you to define custom text formatting markup to be associated with elements in the output pages.

Figure A–23  Output Text Formats - Markup Tab

Table A–26 lists the elements and descriptions for Output Text Formats - Markup Tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to use to refer to this format. This field is required.</td>
</tr>
<tr>
<td>Tag name (default = p)</td>
<td>The HTML paragraph level tag to put around paragraphs using this format. Note that any tag name may be entered here, whether or not it is legal. Only the tag name should be entered, not the surrounding angle brackets (&quot;&lt;&quot; and &quot;&gt;&quot;). The paragraph tag (&quot;p&quot;) is the default.</td>
</tr>
<tr>
<td>Add Attribute</td>
<td>Adds a new name/value pair to the Custom Attributes table. These attributes apply to the tag whose name was specified by the “Tag name” option above. To set the name and value of the new attribute, just click on them in the Custom Attributes table.</td>
</tr>
<tr>
<td>Remove Attribute</td>
<td>Highlight an entry in the Custom Attributes table and click this button to remove the entry.</td>
</tr>
<tr>
<td>Markup to insert before element</td>
<td>HTML (and/or regular text) to write out before all paragraphs using this format.</td>
</tr>
<tr>
<td>Markup to insert after element</td>
<td>HTML (and/or regular text) to write out after all paragraphs using this format.</td>
</tr>
</tbody>
</table>
**Table A–26 (Cont.) Output Text Formats - Markup Tab Elements and Descriptions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a newline in the HTML before this paragraph</td>
<td>This option, if checked, will cause a newline character to be inserted into the HTML before the start tag for the paragraph if Format HTML source for readability option is set under Output Pages. This option does not affect how the output looks in the browser.</td>
</tr>
<tr>
<td>This paragraph should begin a new page</td>
<td>When set, a new output page is created every time this format is applied to a paragraph. By default, this option is off.</td>
</tr>
<tr>
<td>Don’t begin a page for the first paragraph of this type</td>
<td>If This paragraph should begin a new page is selected, then this option turns that behavior off for the first paragraph only. The purpose of this option is to avoid empty or mostly empty pages at the beginning of the output.</td>
</tr>
</tbody>
</table>

**A.5.3.2 Output Text Formats - Formatting Tab**

You can choose one of two ways to specify the formatting for paragraphs: use an external CSS or define formatting in this page.

**Note:** This formatting primarily applies to paragraph styles, though named character styles are also supported. Source documents must be styled correctly in order to enable style overrides from the template. This means that when altering the formatting of a paragraph, the user needs to edit the paragraph style rather than selecting text in the paragraph and manually applying formatting; doing the latter causes the word processor to enclose the text in an unnamed character style. Microsoft Word, for example, indicates this fact by displaying the style as "Heading1 + italic" -- the italic formatting is not part of the style. The correct way to style the paragraph is to create a new "Heading 1(italic)" style and set the formatting attributes accordingly, then apply it to the paragraph.
Table A–27 lists the elements and descriptions for Output Text Formats - Formatting Tab.

Table A–27  Output Text Formats - Formatting Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use CSS class</td>
<td>Specify the name of an externally defined class here. The URL of the CSS file is specified by the External user stylesheet option under Output Pages.</td>
</tr>
<tr>
<td>Character Formatting</td>
<td>Each type of character level formatting available here can be set to one of these values:</td>
</tr>
<tr>
<td></td>
<td>■ Always off - Forces the attribute to always be off when formatting the text.</td>
</tr>
<tr>
<td></td>
<td>■ Always on - Forces the attribute to always be on when formatting the text.</td>
</tr>
<tr>
<td></td>
<td>■ Inherit - Takes the state of the attribute from the source document. In other words, if the source document had the text rendered with bold, then the technology will create bold text.</td>
</tr>
<tr>
<td></td>
<td>■ Do not specify - Leave the formatting unspecified. In certain cases, this will produce different HTML output than Always off. This is useful when the style will be provided by an external stylesheet.</td>
</tr>
</tbody>
</table>
The Add Format Mapping Rules page allows you to access the Format Mapping Rules page. In order to know which text format to use, Format Mapping Rules must be created. Mapping rules pick the formatting based on checking the type of source document text.
Table A–28 lists the elements and descriptions for Output Text Formats - Format Mapping Rules tab.

Table A–28  Output Text Formats - Format Mapping Rules tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Format Mapping Rule</td>
<td>Click this button to add a new format mapping rule.</td>
</tr>
<tr>
<td>Move Up and Move Down</td>
<td>Once mapping rules have been added, their order may be arranged by using these buttons. The mapping rules are ordered so that the first rule that matches is the one, and only one, that is applied. For example, a rule may be created for mapping paragraphs in the “My Style” style. Below that rule, another rule may exist for mapping paragraphs with “outline level 1” applied. An input document may have one or more paragraphs in the ”My Style” style that also have “outline level 1” applied. In this example the technology will only apply the ”My Style” formatting to such paragraphs and ignore the “outline level 1” rule for them.</td>
</tr>
<tr>
<td>Remove</td>
<td>Highlight a mapping rule and click this button to remove it.</td>
</tr>
</tbody>
</table>

A.5.5 Format Mapping Rules

The Format Mapping Rules page is used to map output text formats to output text.
Table A–29 lists the elements and descriptions for Output Text Formats - Format mapping Rule tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>Choose one of the defined formats to apply when this mapping rule is in effect. The Default Paragraph format is always available and is always the default.</td>
</tr>
<tr>
<td>Match on</td>
<td>Defines the paragraph formatting information to have the rule check.</td>
</tr>
<tr>
<td></td>
<td>- outline level - Match the outline level specified in the source document. Application-predefined heading styles typically have corresponding outline levels applied as part of the style definition.</td>
</tr>
<tr>
<td></td>
<td>- style - Match the paragraph or character style name.</td>
</tr>
<tr>
<td></td>
<td>- footnote - Match any footnote.</td>
</tr>
<tr>
<td></td>
<td>- endnote - Match any endnote.</td>
</tr>
<tr>
<td></td>
<td>- header - Match any document header text.</td>
</tr>
<tr>
<td></td>
<td>- footer - Match any document footer text.</td>
</tr>
<tr>
<td>Value</td>
<td>If Match on above is set to Outline level, then this defines which outline level to match.</td>
</tr>
<tr>
<td></td>
<td>If Match on above is set to Style name, then this defines which source document paragraph or character style name to match. When matching on style names, the author is required to supply a style name here and no default value is provided. The name must exactly match the style name from the source document. Style name matching is done in a case-sensitive manner.</td>
</tr>
</tbody>
</table>

A.5.6 Add Output Markup Items

The Add Output Markup Items page allows you to access the Output Markup Items page, where you can add or remove customized markup to output pages.
Table A–30 lists the elements and descriptions for Output Markup Items tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>This button allows you to add a break or another markup item to an output page. Click the button to add an element of this type.</td>
</tr>
<tr>
<td>Remove</td>
<td>Highlight an output markup item and click this button to remove markup items that are no longer needed.</td>
</tr>
</tbody>
</table>

**A.5.7 Output Markup Items**

The Output Markup Items page allows you to define markup to be associated with output items.
Figure A–28  Markup

Table A–31 lists the elements and descriptions for Markup tab.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name to use for referencing this piece of markup. This field is required.</td>
</tr>
<tr>
<td>Markup</td>
<td>Enter the HTML to be inserted into the Markup text entry field.</td>
</tr>
<tr>
<td>OK/Cancel</td>
<td>Save this item by clicking OK, or click Cancel to quit.</td>
</tr>
</tbody>
</table>

A.5.8 Add Output Page Layouts

The Add Output Page Layouts page allows you to access the Output Page Layouts page. Page layouts are used to organize how the various pieces of the output are arranged.
A.5.9 Output Page Layouts

The Output Page Layouts page allows you to define an output page layout and link it to a navigation layout. This is where you define such aspects of the output page as where to place the table of contents. A default layout has been provided for users who need output that is pleasing to the eye, but are not particular about the details of their output. You may create multiple page layouts, which allows you to customize a document navigation system according to file type. Each Document Handling tab allows you to specify a page layout created here to use for that file type.

The <title> source portion of this page allows you to select where the template will get the value to use for the HTML <title> tag. By default, this is empty for new layouts, although the <title> tag will always be output in order to conform to the DTD. The source of the <title> text will be determined from the child elements present.
Figure A–30  Layout - General Tab

Table A–33 lists the elements and descriptions for Layout - General Tab.

Table A–33  Layout - General Tab Elements and Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Fill in the name to use to refer to this layout (required). Once this has been done, click on the Plus sign on the left side of the name (“default” in this example) to expand the levels underneath this one.</td>
</tr>
<tr>
<td>Include navigation layout</td>
<td>This allows you to create a Table of Contents page as a separate file containing markup and links to the document content specified in the page layout. Use of a navigation layout is optional. If you place a check in the box in front of this item, the Navigation Layout tab will become available.</td>
</tr>
</tbody>
</table>
| Source/Name           | Click this to add places to search for the title. The following sources may be examined:  
  - format - Use text mapped to an output paragraph format already defined under the Output Text Formats. Perhaps, for example, from a format created for text in the "Title" style, although any format may be used. The first non-empty instance of a paragraph in this format is used.  
  - text element - Use a text element already defined under Text Element. Using a text element for the title makes a good fail-safe entry at the bottom of the list just in case all other title sources are undefined/unavailable.  
  - property - Use a document property already defined under Document Property; for example, from the "Title" document property, although any property may be used.  
  - section title - Use the title for the current document section. Section titles are not available in all document formats; for example, they are not used in word processing files. Taking the title from the section name is very useful in presentations (the slide title), and spreadsheets and database files (the sheet name). Using the section name works well with output layouts that place one slide/sheet in each output HTML page. In this situation, each page would have a title that matches the title of its contents. If the page layout does not break the document by sections, the name of the first section will be used as the title text. |
A.5.10 Navigation Layout

The purpose of the navigation layout is to generate a separate Table of Contents HTML page based on mapping rules defined under Mapping Rules Tab. This navigation page becomes the first output file of the conversion and is completely independent of other document page-breaking rules in the output.

The navigation layout triggers the creation of a separate file with links to the actual document content. Only navigation items and markup can be inserted into the body of the navigation layout. Page navigation is not supported in the navigation layout; it is intended for use with document and section layout items.

Use of a navigation layout is optional. If one is used, the author can add a page navigation item, with a navigation page link, to the main layout in order to provide access to the navigation page from the other pages of the output document.

Figure A–31  Navigation Layout

There are two layout sections under Navigation Layout: Head and Body. They are listed in Table A–34.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Up and Move Down</td>
<td>The order that the items are listed in the box matches the search order that Dynamic Converter will use to find the title. If no title is available from the first source on the list, then the next source is checked and so on down the list. Use these two buttons to adjust the order as needed.</td>
</tr>
</tbody>
</table>
Table A–34   Navigation Layout Sections

<table>
<thead>
<tr>
<th>Layout Sections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head</td>
<td>This page defines the content that will be placed in the HTML <code>&lt;head&gt;</code> of all of the output files this layout applies to. The technology automatically places the following in the head:</td>
</tr>
<tr>
<td></td>
<td>■ A <code>&lt;meta&gt;</code> tag stating the character set in which the HTML file is encoded.</td>
</tr>
<tr>
<td></td>
<td>■ A <code>&lt;title&gt;</code> tag, the contents of which are defined under Title Source.</td>
</tr>
<tr>
<td></td>
<td>■ A <code>&lt;meta&gt;</code> tag stating that the HTML was generated.</td>
</tr>
<tr>
<td></td>
<td>■ <code>&lt;meta&gt;</code> tags for all document properties defined under Document Property that specify a Meta tag name.</td>
</tr>
<tr>
<td></td>
<td>■ If the CSS generation option was selected under Output Pages, then CSS style definitions generated by the technology are included.</td>
</tr>
<tr>
<td></td>
<td>■ If the External CSS stylesheet option was selected under Output Pages, then an HTML <code>&lt;link&gt;</code> tag to the user-specified CSS file is included.</td>
</tr>
<tr>
<td></td>
<td>■ All markup items listed on this page. Markup items must first be defined under Output Markup Items before they will be available to be inserted here. The markup items specified on this page will appear in the head after all of the auto-generated items listed above. By default, there is nothing listed here.</td>
</tr>
<tr>
<td>Body</td>
<td>This page defines the content that will be placed in the body of the navigation page created by this layout.</td>
</tr>
</tbody>
</table>

Each layout section contains the following elements listed in Table A–35 to control adding, deleting, and setting the sequence of items.

Table A–35   Layout Section Elements

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Up and Move Down</td>
<td>The order that the items are listed in the box matches the order that they will appear at the top of each page. Use these two buttons to adjust the order as needed.</td>
</tr>
<tr>
<td>Remove</td>
<td>Highlight an entry and click this button to remove entries that are not wanted. This only removes the entry from inclusion at the top of each page, the definition of the entry is NOT removed by clicking this button.</td>
</tr>
<tr>
<td>Add</td>
<td>Click this to add entries to the top of each page in the layout. The following items may be placed in the top:</td>
</tr>
<tr>
<td></td>
<td>■ Markup Item - A text and HTML markup item defined under Output Markup Items.</td>
</tr>
</tbody>
</table>

A.5.11 Page Layout

The Page Layout page defines how the document contents are arranged in the output HTML pages.
Click on each of the following layout sections listed in Table A–36 to define how document contents are arranged.

**Table A–36 Page Layout Sections**

<table>
<thead>
<tr>
<th>Layout Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head</td>
<td>Allows you to add markup items to be placed in the HTML <code>&lt;head&gt;</code> of each output file.</td>
</tr>
<tr>
<td>Page Top</td>
<td>Allows you to specify items to be placed at the top of each output page. The following items may be placed:</td>
</tr>
<tr>
<td>Before Content</td>
<td>Allows you to specify markup items to be output before the document content. The following items may be placed:</td>
</tr>
<tr>
<td>Before Section</td>
<td>Allows you to specify items to be inserted before each section of a multi-section document. Note that this is not applicable to word-processing documents. The following items may be placed:</td>
</tr>
</tbody>
</table>
A.6 Previewing and Saving your Template

This section covers the following topics:

■ "Previewing the Template XML Structure" on page A-44
■ "Previewing a Converted Document" on page A-45
■ "Saving your Template" on page A-45

A.6.1 Previewing the Template XML Structure

The HTML Conversion Editor allows you to preview the XML structure of the template as you create it. This preview lets you see the choices you have made in configuring the template. At the top left of the interface, select Tools > View XML structure. The XML structure viewer window is displayed.

---

Table A–36  (Cont.) Page Layout Sections

<table>
<thead>
<tr>
<th>Layout Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Content</td>
<td>Allows you to specify items to be output after the document content. The following items may be placed:</td>
</tr>
<tr>
<td></td>
<td>■ Header - The header from the input document.</td>
</tr>
<tr>
<td></td>
<td>■ Footer - The footer from the input document.</td>
</tr>
<tr>
<td></td>
<td>■ Markup Item - A text and HTML markup item defined under Output Markup Items.</td>
</tr>
<tr>
<td></td>
<td>■ Text Element - A text element defined under Text Element.</td>
</tr>
<tr>
<td>Page Bottom</td>
<td>Allows you to specify items to be placed at the bottom of each output page, for example, a copyright notice. The following items may be placed:</td>
</tr>
<tr>
<td></td>
<td>■ Footer - The footer from the input document.</td>
</tr>
<tr>
<td></td>
<td>■ Navigation Item - A navigation item defined under Add Navigation Element.</td>
</tr>
<tr>
<td></td>
<td>■ Markup Item - A text and HTML markup item defined under Output Markup Items.</td>
</tr>
<tr>
<td></td>
<td>■ Text Element - A text element defined under Text Element.</td>
</tr>
</tbody>
</table>
A.6.2 Previewing a Converted Document

As you configure your template, there is a useful tool that allows you to see how a specified source document would appear after the template is applied.

1. The first step is to set the document for preview. At the top left of the interface, enter the **Preview document ID** in the text field. This is the Content ID for a document previously checked into Content Server that you want to preview.

2. Click the Preview button at the top right of the interface. Your default browser is launched and displays a preview of the converted document.

A.6.3 Saving your Template

If you start to exit the HTML Conversion Editor with unsaved changes, a dialog will prompt you to select among three choices:

- Save & Exit
- Exit
- Cancel
absolute URL
The full Internet address of a Web page. It consists of the transfer protocol, network location, and optional path and file name. For example: http://www.company.com/news/update.htm, where ‘http’ defines the transfer protocol, ‘www.company.com’ identifies the server where the document resides, ‘news’ is a subdirectory, and ‘update.htm’ is the file name.

active link
The currently selected link on a Web page. Web browsers often display links in a different color when clicked and change the color again, once the reader has visited the site or page the link points to.

Active Server Pages
A Microsoft scripting language capable of performing server side functions with Microsoft Internet Information Server (IIS). ASP (and more recently ASP+) can be used to build dynamically assembled Web pages that draw information (using queries) from a relational database. ASP pages contain the .asp file extension.

ActiveX control
A component that can be embedded in a Web page to provide functionality not directly available in HTML, such as animation sequences and spreadsheet calculations. ActiveX controls can be activated in a number of programming languages.

Address (System)
A special element that is part of every template in Dynamic Converter. Used to format an address in a Web page, that is, the information entered under Address Lines in the Address tab dialog of the Globals property sheet.

administrator
A person or computer login that has maximum privileges over the computer or network. Administrative access includes the ability to use every Element of the system and assign unique privileges to other users.

anchor
A named location on a Web page that serves as the target of another link. Anchor tags allow you to link to a specific section of a Web page. In a URL, an anchor is preceded by the pound (#) sign. Anchors are also called bookmarks.
**applet**
Short for Java applet, a short program written in Java that is embedded in a Web page and executed by a Web browser. Java applets are frequently used to add interactivity or application functions to a Web page. Java applets can be read by Microsoft Internet Explorer, Netscape Navigator, or any Web browser capable of interpreting Java.

**ASCII**
American Standard Code for Information Interchange. A universally recognized text-only format that contains characters, spaces, punctuation, etc., but no formatting information. You can transfer ASCII files between programs that could not otherwise understand each other’s documents. HTML files can be encoded in ASCII format.

**background color**
The color setting of a Web page or table cell.

**background graphic**
The graphic used instead of a color for the background of a Web page. Each graphics set in Dynamic Converter includes a background graphic that is automatically applied to all Web pages created from the template the graphics set has been applied to.

**base URL**
An optional URL that you can assign to a Web page to convert relative URLs on the page to absolute URLs. A base URL should end with a document name, such as http://www.company.com/news.htm, or a trailing slash, such as http://www.company.com/news/. A base URL is also called a base location.

**bitmap (.bmp)**
A Windows-compatible graphics file format in which the image is represented by a series of bits. Dynamic Converter converts numerous image types, including bitmaps, in source documents into the GIF, JPEG, PNG, WBMP, or BMP format.

**bookmark**
1) A means to store a Web site or other Internet URL for future use. Instead of entering the URL each time a user wants to visit a site, the user can open the URL once, ‘bookmark’ the URL, then use the bookmark to make subsequent visits. Bookmarks are also called ’Favorites.’

2) A named location on a Web page that serves as the target of another link. Bookmarks allow you to link to a specific section of a Web page. In a URL, a bookmark is preceded by the pound (#) sign. Bookmarks are also called anchors.

**broken link**
A link that points to a URL or file that does not exist (or one that cannot be found by the computer).

**bulleted list**
A series of related items in paragraphs set off by bullets. Also known as an unordered list.

**Cascading Style Sheets (CSS)**
A means of separating structure from presentation so as to introduce layout control over Web pages. Style sheets can be included in an HTML document by (a) linking to an outside style sheet, (b) embedding a document-wide style in the <HEAD> tag of the document, or (c) embedding inline styles where needed. Dynamic Converter
implements CSS both the second and third way. (Outside style sheets can be added by using the "Include HTML or scripting code before content" option.)

**cell**
The smallest component of a table.

**cell padding**
The amount of space between the content and border of a table cell.

**cell spacing**
The amount of space between cells in a table.

**character**
A single alphabetic letter, numeric digit, or special symbol such as a decimal point or comma.

**character element**
A element used to format only characters, that is, a portion of text in a paragraph.

**core HTML tags**
The most commonly used HTML tags: six heading tags, the paragraph tag for all text, and two tags for handling lists.

**Default Character**
A special element that can be associated with any character in a source document that is not associated with a specific style.

**Default Paragraph**
A special element that Dynamic Converter assigns to content in a source document that is not associated with any other element.

**Default.tcp**
One of two default project files in Dynamic Converter. A copy of the project file opens automatically when you start a new HTML project. The project file is installed in the Dynamic Converter directory (a copy is also available in the Support folder of the Dynamic Converter product disc). A second default project file, DefaultWML.tcp, is used to create WML projects.

**DefaultWML.tcp**
One of two default project files that is installed in the Dynamic Converter directory (and is also available on the Dynamic Converter product disc). Dynamic Converter opens a copy of DefaultWML.tcp each time you start a new WML project. DefaultWML.tcp is used to create WML projects. You use Default.tcp to create HTML projects.

**directory**
The name of a storage area on a computer’s disk drive that contains a collection of files, other directories, or both. The directory name should identify its contents. In the Windows operating system, a directory is represented by a yellow icon that resembles a manila folder. Directories are also called folders.
**domain name**
A name that resolves or points to an IP address. Domain names give a 'friendly name' to a Web site, making it easy for users to find the Web site on the World Wide Web.

**download**
To transfer a file from a remote computer to a local machine.

**effect**
A characteristic of a portion of text in a document, such as bold, italic, or subscript. Dynamic Converter lets you retain or change such effects when you translate source documents.

**element**
Similar to a style name used in a word-processing template. Dynamic Converter assigns elements to the ranks it creates for content in source documents. An HTML tag is assigned to each element, and the elements are saved in the template.

**element button bar**
A navigation aid consisting of buttons with labels such as "Previous" and "Next" to denote their purpose. Used to move between elements within Web pages.

**element link**
A link at the element level that allows readers to jump between content associated with a specific element in a Web page.

**Element Setup**
A property sheet in Template Editor in which you manage elements.

**element text bar**
A navigation aid consisting of text drawn from elements. Used to move between elements within Web pages.

**email**
Electronic mail. The transmission of messages electronically over a network.

**Email (System)**
A special element that is part of every template in Dynamic Converter. Used to format an email address in a Web page, that is, the information entered in the Email Prompt text box in the Address tab dialog of the Globals property sheet.

**embedded files**
A graphic, sound, or object included in a document (such as a Microsoft Word document). Dynamic Converter converts embedded objects into graphics and also creates a link to the object in its native format (such as .xls for Microsoft Excel documents).

**Favorites**
To store a Web site or other Internet URL for future use. Instead of entering the URL each time a user wants to visit a site, the user can open the URL once, save the URL as a 'Favorite,' then use the Favorite to make subsequent visits. Favorites are also called 'Bookmarks.'
file
A named collection of information that is stored in a file system.

file extension
The part of a file name that identifies the purpose or use of the file. File extensions determine file type. As a result, software applications are able to read the file as necessary. For example, files with the .txt extension can be opened with a text editor; files with the .bmp extension can be opened with a graphics editor; and files with the .exe extension can be run by the operating system.

file server
A computer running on a network that stores files and provides local and remote access to them. File servers are also called Web servers.

file type
The format of a file, usually indicated by its file name extension. Most software applications work with a specific set of file types.

folder
The name of a storage area on a computer's disk drive that contains a collection of files, other folders, or both. The folder name should identify its contents. In the Windows operating system, a folder is represented by a yellow icon that resembles a manila folder. Folders are also called directories.

font
Set of characters of a particular design and size. A typeface is composed of fonts. Arial is a typeface; Arial 12 point roman bold is a font.

Formatting
A property sheet in Dynamic Converter in which you format the content of your Web pages.

Gallery
A dialog box in Template Editor that offers over 900 graphics that serve as navigation and visual aids to fine-tune the appearance of Web pages. Many of the graphics are organized in 28 Sets, which ensure that the buttons, bullets, separators, and background in your Web page are all of a consistent design.

GIF (.gif)
Graphics Interchange Format, a compressed graphics file that handles eight-bit color (256 colors) and achieves a compression ratio of roughly 2:1. GIF images are a popular graphic file format on the Internet because of the reduced download time. GIFs are one of the default formats that Dynamic Converter uses to convert graphics imported in source documents.

global setting
Any option in Dynamic Converter set in the Globals property sheet. Associated with a specific template rather than an individual element within the template.

Globals
A property sheet in Dynamic Converter where you format the template as a whole, as opposed to its individual elements. For example, you can create a background color
for all documents associated with that template, and this color will be used for all Web pages created when those documents are translated.

**graphic**
A particular type of file that typically displays an image rather than text. Dynamic Converter accepts graphics in a variety of formats when it translates source documents into Web pages. It converts them into the GIF, JPEG, PNG, BMP, or WBMP format. Dynamic Converter also includes a Gallery of graphics for use as navigation and visual aids in Web pages.

**graphics set**
A collection of graphics provided in Dynamic Converter, available from the Gallery. Each graphics set is uniquely designed and consists of a series of navigation buttons, a bullet, a separator, and a background. There are 28 Sets in Dynamic Converter.

**GUI**
Graphical user interface, a graphics-based user interface that incorporates icons and menus and allows users to use a mouse to execute commands. GUIs create visually oriented interfaces that make it easy for users to interact with computerized information of all kinds.

**header**
The initial portion of an HTML file between the `<HEAD>` and `</HEAD>` tags where titles are commonly supplied.

**heading**
A text style that displays in a larger typeface than the default or normal text. Headings denote hierarchy in a document. A Heading 1 is generally the largest, a Heading 2 the next largest, and so forth. A Heading tag in HTML denotes the same hierarchy.

**heading level**
A level in the hierarchy of a document. Heading levels help structure content. Documents often contain several heading levels with style names such as Heading 1 and Heading 2. Each heading would be set in a different font size or weight to denote its level of importance.

**hotspot**
A portion of text or an image that contains a link. Clicking the hotspot takes the user to related information. In Web browsers, hotspots are invisible. Users can tell that a hotspot is present by the changing appearance of the pointer.

**HTM**
The default extension for output HTML files created in Dynamic Converter.

**HTML**
HyperText Markup Language. The markup language used to turn a document into a Web page that can be viewed in a Web browser. HTML tags are used to format the text and the background of the document. HTML pages contain the .html or .htm file extension.

**HTML 4.0**
The current standard administered by the W3C (more specifically, version 4.01). Most Web browsers will support version 4.0 and 4.01.
**HTML file**
What Dynamic Converter produces when it translates a source document. Each HTML file displays as a Web page in a Web browser. (If a source document is split into several HTML files, each file displays as a single Web page.)

**HTML format**
The format used to view documents in a Web browser. Files in HTML format are text files with HTML tags assigned to blocks of text. Dynamic Converter turns source documents into body pages that are in HTML format.

**HTML tags**
A collection of symbols that specify the appearance and properties of a document. Web browsers interpret HTML tags and display the contents in the browser window.

**HTTP**
The protocol used by Web browsers and Web servers to communicate over the Internet. More specifically, a Web browser requests a document from a Web server and displays its contents using HTTP. The HTTP protocol appears at the beginning of a URL (for example, http://). The HTTP specification is maintained by the World Wide Web Consortium.

**HTTPS**
HTTPS is standard HTTP exchanged over an SSL-encrypted session.

**link**
A jump from a piece of text or image in one document to another document located within the Web page, the file system, a network, or the Internet. Dynamic Converter creates hyperlinks automatically for navigation purposes. Dynamic Converter also preserves hyperlinks in source documents that can take the user, for example, to another Web site. Hyperlinks are the primary means of navigating on the World Wide Web. Hyperlinks are also called links.

**hypertext**
A nonlinear way to organize information, especially text. Hypertext provides a way to adapt text, graphics, and other kinds of data for computer use so that individual data elements point to one another. Any document that contains hypertext links to other documents is a hypertext document. Most Web pages are hypertext documents.

**hypertext link**
A hotspot overlaid on a graphic or piece of text. Facilitates navigation within and between Web pages according to users’ interests. When readers click the hypertext link, they’re taken to another part of the Web page or Web page.

**image**
A graphic in GIF, JPEG, PNG, BMP, or WBMP format that can be inserted into a Web page. Dynamic Converter lets you import graphics in a variety of formats and convert them into one of these five formats.

**Image tag**
The HTML image tag <IMG> for placing graphics in-line in Web pages. Used with Web browsers that support HTML 2.0 and later versions.
inline image
An image embedded in a line of text rather than its own window. Can appear by itself or merged with displayed text.

Internet
A global computer network composed of thousands of Wide Area Networks (WANs) and Local Area Networks (LANs) that use TCP/IP to provide worldwide communication to governments, universities, businesses, organizations, and individuals. The Internet hosts the World Wide Web.

Internet address
A unique identifier for a Web site on the Internet. Users can access a Web site by entering its Internet address in a Web browser address bar or clicking a link that contains the Internet address. For example, http://www.company.com. Also known as host name or network location.

Internet Explorer
Microsoft’s Web browser used to interpret HTML markup and Internet protocols (HTTP and FTP), thus allowing users to browse the World Wide Web. Dynamic Converter provides previewing capabilities of both templates and Web pages using Internet Explorer or Netscape Navigator.

Internet Information Services
Microsoft’s Web server software used to deliver Web pages on the World Wide Web. IIS incorporates numerous server-side functions for its native ASP (Active Server Page) scripting language. IIS can also be used as an FTP server to transfer documents over the Internet.

intranet
One or more Web servers located inside an organization’s internal network that are used to store internal company information. Intranets generally exist as a separate Web site from an external or customer Web site. Anyone connected directly to the network, such as an employee, can access the intranet site.

IP address
A numerical address that identifies a computer on the Internet. An IP address comprises four sets of numbers (up to three digits each) separated by periods. An IP address can be used as an alternative to a domain name when the domain name is assigned a dedicated IP.

Java
A general-purpose programming language created by Sun Microsystems. Java can be used to create Java applets. A Java program is downloaded from the Web server and interpreted by a program running on the machine containing the Web browser.

Java Server Page
A technology for serving Web pages through the use of servlets, or small programs that run on the Web server. JSP is similar to Microsoft’s Active Server Pages (ASP) they both request programs from the Web server before displaying the results in a Web browser. JSP pages contain the .jsp file extension.
**JavaScript**
A cross-platform, Web scripting language developed by Netscape Communications and Sun Microsystems, Inc. Compared to Java, JavaScript is limited in performance because it is not compiled before execution. Basic online applications and functions can be added to Web pages with JavaScript, but the number and complexity of available application programming interface functions are fewer than those available with Java. JavaScript code can be added to existing HTML code in a Web page.

**JPEG (.jpg)**
Joint Photographics Experts Group. A compressed graphics file format used to display high-resolution color graphics. JPEG is a popular format for photographs and images rich in color and detail. Dynamic Converter can convert graphics in source documents into the JPEG format.

**link**
A pointer in one part of a Web page that a reader can click to navigate to related information in another part of the same publication or in another publication entirely. Links permit rapid, easy movement between related information and are often coded to change color once they have been selected or used on the Internet.

**list**
A series of related items in paragraphs, usually set off by numbers (a numbered or ordered list) or bullets (a bulleted or unordered list).

**list element**
An item in a list tagged with the HTML List Item tag `<LI>`.

**local link**
A link that connects two pieces of related information in the same Web page.

**logging in**
The process of identifying oneself to an account through a username and password.

**markup**
The process of embedding special characters in a text file that tells a computer program how to handle the contents of the file itself. HTML tags are a form of markup.

**markup language**
A defined set of markup tags.

**Meta tag**
The HTML tag that must appear in the `<HEAD>` portion of an HTML file. A Meta tag supplies information about a Web page but does not affect its appearance.

**metadata**
"Data about data." In addition to content, the typical source document has a title, author, and other properties associated with it that can be used in different ways. Dynamic Converter recognizes standard and custom metadata. Standard metadata are automatically generated by the application that was used to create the source document. Custom metadata are properties that you create in the application for the source document. (Not every document has standard or custom metadata.)
**named style**
A set of formatting characteristics that have been saved and assigned a name, and which can be applied to any paragraph in a source document. For example, Heading 1, which may be Arial 18-point bold.

**navigation**
The process of using links and other devices to move within and between Web pages.

**Navigation**
A property sheet in Dynamic Converter in which you add navigation aids to your Web page.

**navigation aid**
A pointer in one part of a Web page that guides readers to related information in another part of the same publication or another publication entirely. Links permit rapid, easy movement between related information. Navigation aids often come in the form of buttons with labels such as "Previous" and "Next" to denote their purpose.

**navigation bar**
A series of hypertext links arranged on a single line of a Web page to provide a set of navigation controls for a Web page. Dynamic Converter lets you create both button and text bars, for a Web page as a whole and for specific elements.

**Netscape Navigator**
Netscape's Web browser used to interpret HTML markup and Internet protocols (HTTP and FTP), thus allowing users to browse the World Wide Web. Dynamic Converter provides previewing capabilities of both templates and Web pages using Netscape Navigator or Internet Explorer.

**numbered list**
A series of related items in paragraphs, numbered sequentially. Also known as an ordered list.

**OLE**
Object Linking and Embedding. A technology or method for sharing information between applications. If a Word or Excel document in Dynamic Converter contains an embedded object, that object can be converted to a linked graphic file that targets the object in its native application.

**online**
Information, activity, or communications located on or taking place in an electronic, networked computing environment like the Internet. The opposite of off-line, which is how you work when your computer is not connected to the Internet or any network.

**output HTML file**
The file that Dynamic Converter creates when it converts a source document into a body page.

**page**
A Web page, that is, a single file that users view in a Web browser. Web pages typically consist of many Web pages, the one that opens by default being the home page. Pages must be linked to enable users to navigate through a Web page.
**page button bar**
A navigation aid for moving between Web pages, consisting of buttons with labels such as "Previous" and "Next" to denote their purpose.

**page text bar**
A navigation aid for moving between Web pages consisting of text drawn from specific elements.

**paragraph**
The fundamental unit of a text or word processing file that defines content. A paragraph can be associated with only one style. In an HTML file, it is defined by the markup tag <P>.

**parent directory**
A directory that contains other directories. Directories are also called 'folders.'

**password**
A string of letters and numbers associated with a username that together make up a login. The password adds security to the login, preventing others from using it to gain access to the computer or network. A password character usually display as an asterisk (*) to prevent others from seeing or using the password.

**path**
The sequence of drive, directory, and subdirectory names that defines a file's location, such as C:\Program Files\Dynamic Converter\. Also refers to the portion of a URL that identifies the folder containing a file. In http://www.company.com/tech/more/support.htm, the path would be /tech/more/.

**pattern**
A set of text attributes in a source document that Dynamic Converter can identify and associate with an element. If a manually formatted source document has headings in Arial, 18-point, bold, you can base a pattern on these attributes and associate this pattern with an element. You can then use this element to format the content associated with the pattern. There are two kinds of patterns in Dynamic Converter: paragraph and character.

**pattern attribute**
An individual character or text attribute such as Bold used to create a pattern.

**pattern string**
The string of characters used by Dynamic Converter to identify a pattern in a source document. For example, the pattern string [Bullet][A-Z][A-Za-z]+ tells Dynamic Converter to search for a pattern of text in the source document that begins with a bullet, followed by an upper-case letter, followed by one or more upper-case or lower-case letters.

**pixel**
Short for picture element. A pixel is the smallest 'dot' your computer screen is capable of rendering at the resolution determined by your hardware and software. The size of a pixel may vary from system to system, depending on your graphics adapter, the screen resolution specified in the operating system setup, etc. Common screen resolutions are 640 by 480 pixels, 800 by 600, 1024 by 768, and 1280 by 1024.
**plug-in**
One of a set of software modules that can be integrated into a Web browser to offer a range of interactive and multimedia capabilities.

**PNG (.png)**
Portable Network Graphics. New graphics format designed to replace the older and simpler GIF format. Offers superior compression and display capabilities. One of five formats available in Dynamic Converter when converting graphics in source documents.

**Preview window**
A window inside a dialog box that shows you what your source document will look like in a Web browser, once translated.

**properties**
The characteristics of a source document, element, rank, style, or pattern. For example, the name of a document is one of its properties. Properties can be viewed and edited in the various Properties dialog boxes.

**property sheet**
An interface in Dynamic Converter with a series of tabs that provide access to commands and options for carrying out specific tasks. Element Setup, Formatting, Navigation, and Globals are all property sheets.

**protocol**
A method for two devices to communicate over the Internet. A protocol is an algorithm, or step-by-step procedure, carried out by such devices. File Transfer Protocol (FTP) and HyperText Transfer Protocol (HTTP) are protocols used to transfer files over the Internet.

**rank**
Used by Dynamic Converter to identify the structure of a source document based on the hierarchy of content in that document. As a result, the top-level hierarchy of each source document is treated the same.

**raster image**
An image formed by light and dark pixels in a rectangular array, rather than by a collection of lines, as in a vector graphic.

**relative URL**
The Internet address of a Web page with respect to the Internet address of the current page. A relative URL gives the path from the current location of the page to the location of the destination page. For example, the relative path from fileA.htm to fileB.htm, where fileB.htm is stored in a subfolder called 'news,' would be 'news/fileB.htm.'

**root web**
The default or top-level of a Web site. The root web can be accessed by entering the Web site URL without specifying a subfolder or Web page. In Dynamic Converter, the root web location is specified in the Output directories of the root publication properties.
**RTF (.rtf)**

**script**
A type of computer code that can be executed by a program that understands the scripting language. Unlike most computer code, a script does not need to be compiled to run. Many scripts are placed on Web servers where they are read and executed by Web browsers.

**separator**
A graphical aid similar to a rule that Dynamic Converter can place in a document to set off different portions of the content.

**server**
A computer that offers services on a network. On the Web, servers run the Web server software that responds to HTTP protocol requests and delivers Web pages.

**SGML**
Standard Generalized Markup Language. An ISO (International Standards Organization) markup language for defining and using a set of tags to denote the nature of document content. HTML is based on SGML.

**signature**
An identifier you can add to a Web page to specify such things as the Webmaster or copyright information. You do this in the Address tab dialog of the Globals property sheet.

**source document**
The content you want to translate into HTML as part of your overall Web site. Dynamic Converter converts source documents from many formats into Web viewable formats. Once you translate a source document, it becomes a Web page for viewing in a Web browser.

**split**
The process of taking a source document and turning it into multiple Web pages to facilitate browsing and downloading. A default option in Dynamic Converter allows you to use Heading 1 to split a document into a series of Web pages, each beginning with Heading 1 content. (You can use another element if you prefer, or even multiple elements.) Another option allows you to create multiple Web pages by splitting on each hard return in the source document.

**style**
A set of formatting characteristics with an assigned name that defines how text appears in a document. In Dynamic Converter, there are two kinds of styles: paragraph and character. Styles can be assembled together to make up a style sheet or Cascading Style Sheet.

**tab dialog**
A particular type of dialog box in Dynamic Converter that you open by clicking a tab on one of the property sheets, for example, the Character tab on the Formatting property sheet.
**table**
A series of cells organized in rows and columns used to arrange data systematically. In HTML, a table can be used to organize the layout of items (text, graphics, etc.) on a Web page.

**tag**
The formal name for an HTML markup element. HTML tags are enclosed in angle brackets (< >). Dynamic Converter automatically generates an element for each rank it applies to source content, and then assigns an HTML tag to each element.

**TCP (.tcp)**
The extension for a project file created in Dynamic Converter.

**TCP/IP**
Transport Control Protocol/Internet Protocol, a standard format for transferring data in packets from one computer to another. This protocol is used on the Internet and other networks. The first part of this standard, TCP, constructs the data packets; the second part of this standard, IP, routes the packets from computer to computer.

**template**
A set of formatting and other instructions for text and images that determines how a source document will display in a Web browser once it is translated. Most of the instructions are associated with the individual elements that reside in the template, though some are associated with the template itself.

**text mode**
A mode of operation in which a computer or Web browser displays letters, numbers, and other characters but no graphical images. A text mode Web browser cannot display graphics without the assistance of a helper application.

**thumbnail**
A miniature rendering of an image used as a placeholder and linked to the full-sized image.

**TIFF (.tif)**
Tagged Image File Format. A tag-based image format used for the universal interchange of digital graphics. Dynamic Converter can convert TIFF images into the GIF, JPEG, PNG, WBMP, or BMP format.

**title**
1) Text supplied between the <TITLE> and </TITLE> tags in an HTML file to define the caption that displays in the title bar of the Web page when it’s viewed in a Web browser.

2) The text that can be added at the beginning of a Web page in Dynamic Converter. (You set titles in the Titles tab dialog of the Globals property sheet.)

**Title (System)**
A special element that is part of every template in Dynamic Converter. Used to format titles in a Web page, that is, the information set in the Titles tab dialog of theGlobals property sheet.
token
A snippet of code that can be placed in an template in place of a file name or path statement. The token acts as a variable (or placeholder) for other content. This content could be a graphic file, template settings, and more. When a document is translated, the token is replaced with the correct path and file name for the content it represents.

translation
The process of creating Web pages from source documents in Dynamic Converter. The formatting and other instructions contained in a template control the translation details. The source documents remain unchanged.

transparent GIF
A specially rendered GIF image in which one ‘color’ is transparent, allowing the background to show through. This type of graphic blends with the document’s existing color scheme and provides a more professional-looking Web page. Not all Web browsers are capable of handling transparent GIFs.

UNIX
A multi-user and multitasking operating system that exists in various forms and implementations. Unix is typically used with proprietary computer and software systems and unlike Microsoft Windows, it is primarily a command line environment.

upload
To transfer a file from a local computer to a remote computer on a network or the Internet.

URL
Uniform Resource Locator. A unique address that specifies where a document can be found on the Internet along with the protocol needed to locate the document (such as HTTP or FTP). URLs tend to be quite long, and you must enter the exact address in order to view the Web site associated with the URL.

username
A string of letters (and possibly numbers) that together with a password make up a login. Your username uniquely identifies you to the computer or network you are logging on to.

VBScript
A subset of the Microsoft Visual Basic programming system. Major Web browsers can read VBScript that is embedded in a Web page. VBScript can be executed on the Web server and the Web browser machine. Microsoft ASP (Active Server Pages) supports VBScript functions.

vector graphics
An image created by a collection of lines rather than a pattern of dots (pixels), as in a raster image.

visited link
A link on a Web page that has been activated. Visited hyperlinks are usually displayed in a unique color by the Web browser.
**watermark**
An image that appears on the background of a Web page that is used to decorate and identify the page or Web site but does not scroll as the page scrolls.

**Web**
An abbreviation for World Wide Web. A subset of Internet servers that support HTTP protocol and can host hypertext documents.

**web browser**
Software that is used to request information from the Internet, interpret HTML markup, and display Web pages to the user. Microsoft Internet Explorer and Netscape Navigator are among the most common Web browsers.

**web page**
A file containing HTML intended for display in a Web browser. Web sites are comprised of individual Web pages that contain hyperlinks to one another. Dynamic Converter creates Web pages and ultimately Web sites from your source documents when you translate your publication.

**web server**
A computer connected to the Internet that stores files and makes them available to the public. Web server software runs on top of an operating system.

**web site**
A collection of HTML or scripting-based Web pages that are linked together and stored on a Web server. Every Web site has a unique URL so that it can be accessed publicly on the World Wide Web.

**webmaster**
A person who creates and maintains the content and organization of a Web site. In Oracle’s content management system, this individual is responsible for reviewing a project on the staging server and for authorizing its final approval and release to the Web site (publishing server).

**World Wide Web**
A subset of Internet servers that support HTTP protocol and can host hypertext documents. Hypertext documents may contain text, pictures, sounds, and other media. Users view such documents using a Web browser. The World Wide Web is also called the ‘Web.’

**World Wide Web Consortium (W3C)**
A consortium of institutions that performs research and promotes standards in areas related to the World Wide Web.